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Conventions used in this guide

TIP: Tips provide helpful hints or shortcuts.

NOTE: Notes provide important information to explain a concept or to complete a task.

CAUTION: Cautions indicate procedures that you should follow to avoid losing data or damaging the 
product.

WARNING! Warnings alert you to specific procedures that you should follow to avoid personal injury, 
catastrophic loss of data, or extensive damage to the product.
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1 Product basics

● Product comparison

● Environmental features

● Accessibility features

● Product views
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Product comparison

HP LaserJet Pro CP1025

CE913A

HP LaserJet Pro CP1025nw

CE914A

● Speed: Prints up to 16 A4-size pages per minute (ppm) or 17 letter-
size ppm monochrome and 4 ppm color

● Tray: 150 sheets of 75 g/m2 (20 lb)

● Output bin: 50 sheets of 75 g/m2 (20 lb)

● Connectivity: Hi-Speed USB 2.0 port

● Two-sided printing (duplexing): Manual duplexing (using the 
printer driver)

● Introductory print cartridge: Supplied with product

HP LaserJet Pro CP1025 plus:

● Connectivity: 802.11b/g/n wireless networking, built-in 
networking to connect to 10Base-T/100Base-TX networks

● Internal networking: HP internal networking port

Environmental features

Recycling Reduce waste by using recycled paper.

Recycle print cartridges by using the HP return process.

Energy savings Save energy with HP Auto-On/Auto-Off Technology.

Manual duplex printing Save paper by using the manual duplex printing setting.

Print multiple pages per 
sheet

Save paper by printing two or more pages of a document side-by-side on one sheet of paper. Access this 
feature through the printer driver.
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Accessibility features
The product includes several features that aid users with accessibility issues.

● Online user guide that is compatible with text screen-readers.

● Print cartridges and the imaging drum can be installed and removed by using one hand.

● All doors and covers can be opened by using one hand.

ENWW Accessibility features 3



Product views

Product front view

1

3

4

6

5

2

1 Output bin

2 Control panel

3 Power button

4 Main-input tray

5 Front cover (provides access to the imaging drum)

6 Print cartridge door (provides access to the cyan, magenta, yellow, and black print cartridges)
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Product back view

1

3

4

5

2

1 Kensington lock

2 Rear jam-access door

3 HP internal network port (network models only)

4 USB port

5 Power receptacle

Serial number and model number location

The label that contains the product and serial numbers is on the inside of the front cover.
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Control panel layout

1

89

2

3

4

5

6

7

1
 Wireless button and light

Press and hold the button to enable Wi-Fi Protected 
Setup (WPS) (network models only). The light indicates 
the state of the wireless connection.

2-5
 Cartridge buttons and lights

When the print cartridge door is closed, press the 
button to access the print cartridge of the 
corresponding color. The light indicates the state of the 
print cartridge.

6
 Attention light

Indicates that the print-cartridge door is open or other 
errors exist.

7
 Ready light

When the light is on, the product is ready to print, When 
the light is blinking, the product is processing data.

8
 Resume button

Press to resume a print job.

9
 Cancel button

Press to cancel a print job.
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2 Software for Windows

● Supported operating systems for Windows

● Supported printer drivers for Windows

● Change print job settings for Windows

● Change printer-driver settings for Windows

● Remove software for Windows

● Supported utilities for Windows (network models only)
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Supported operating systems for Windows
The product comes with software for the following Windows® operating systems:

● Windows 7 (32-bit and 64-bit)

● Windows Vista (32-bit and 64-bit)

● Windows XP (32-bit, Service Pack 2)

● Windows Server 2003 (32-bit, Service Pack 3)

● Windows Server 2008 (32-bit and 64-bit)

Supported printer drivers for Windows
The product comes with software for Windows that allows the computer to communicate with the product. 
This software is called a printer driver. Printer drivers provide access to product features, such as printing on 
custom-sized paper, resizing documents, and inserting watermarks.

NOTE: The most recent drivers are available at www.hp.com/support/ljcp1020series. 
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Change print job settings for Windows

Tool for changing the settings Method for changing the settings Duration of changes Hierarchy of changes

Software program settings On the File menu in the software 
program, click Page Setup or a 
similar command.

These settings are in effect for the 
current print job only.

Settings changed here override 
settings changed anywhere else.

Printer Properties in the software 
program

The steps vary for each software 
program. This procedure is most 
common.

1. On the File menu in the 
software program, click 
Print.

2. Select the product, and then 
click Properties or 
Preferences.

3. Change the settings on any of 
the tabs.

These settings are in effect for the 
current session of the software 
program.

Settings changed here override 
default printer driver settings and 
default product settings.

Default printer driver settings 1. Open the list of printers on 
your computer, and select 
this product.

NOTE: This step varies for 
each operating system.

2. Click Printer, and then click 
Printing Preferences.

3. Change the settings on any of 
the tabs.

These settings remain in effect 
until you change them again.

NOTE: This method changes the 
default settings for the printer 
driver for all software programs.

You can override these settings by 
changing settings in the software 
program.
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Change printer-driver settings for Windows

Change the settings for all print jobs until the software program is closed

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

The steps can vary; this procedure is most common.

Change the default settings for all print jobs

1. Windows XP, Windows Server 2003, and Windows Server 2008 (using the default Start menu view): 
Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the Classic Start menu view): 
Click Start, click Settings, and then click Printers.

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware and Sound click 
Printer.

Windows 7: Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Printing Preferences.

Change the product configuration settings

1. Windows XP, Windows Server 2003, and Windows Server 2008 (using the default Start menu view): 
Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the Classic Start menu view): 
Click Start, click Settings, and then click Printers.

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware and Sound click 
Printer.

Windows 7: Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Properties or Printer properties.

3. Click the Configure tab.
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Remove software for Windows
Windows XP

1. Click Start, and then click Programs.

2. Click HP, and then click the product name.

3. Click Uninstall, and then follow the onscreen instructions to remove the software.

Windows Vista and Windows 7

1. Click Start, and then click All Programs.

2. Click HP, and then click the product name.

3. Click Uninstall, and then follow the onscreen instructions to remove the software.
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Supported utilities for Windows (network models only)
● HP Embedded Web Server (The HP EWS is only accessible when the product is network connected, not 

when the product is connected via USB.)
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3 Use the product with Mac

● Software for Mac

● Print with Mac
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Software for Mac

Supported operating systems for Mac

The product supports the following Mac operating systems:

● Mac OS X 10.5, 10.6, and later

NOTE: For Mac OS X 10.5 and later, PPC and Intel® Core™ Processor Macs are supported. For Mac OS X 10.6, 
Intel Core Processor Macs are supported.

Supported printer drivers for Mac

The HP LaserJet software installer provides PostScript® Printer Description (PPD) files, and Printer Dialog 
Extensions (PDEs) for use with Mac OS X computers. The HP printer PPD and PDE files, in combination with the 
product printer driver, provide full printing functionality and access to specific HP printer features.

Install software for Mac operating systems

Install software for Mac computers connected directly to the product

This product supports a USB 2.0 connection. Use an A-to-B type USB cable. HP recommends using a cable that 
is no longer than 2 m (6.5 ft).

1. Connect the USB cable to the product and the computer.

2. Install the software from the CD.

3. Click HP Installer icon, and follow the onscreen instructions.

4. On the Congratulations screen, click the OK button.

5. Print a page from any program to make sure that the printing software is correctly installed.
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Install software for Mac computers on a wired network

Configure the IP address

1. Connect the network cable to the product and to the network.

2. Wait for 60 seconds before continuing. During this time, the network recognizes the product and assigns 
an IP address or host name for the product.

3. Press and hold the Resume  button for two to three seconds to print a configuration page and a 
supplies status page.

4. Find the IP address on the configuration report.

LASERJET PROFESSIONAL 

Install the software

1. Quit all programs on the computer.

2. Install the software from the CD.

3. Click the HP Installer icon, and follow the onscreen instructions.

4. On the Congratulations screen, click the OK button.

5. Print a page from any program to make sure that the printing software is correctly installed.
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Install software for Mac computers on a wireless network

Before installing the product software, make sure the product is not connected to the network using a 
network cable.

If your wireless router does not support Wi-Fi Protected Setup (WPS), obtain the wireless router network 
settings from your system administrator, or complete the following tasks:

● Obtain the wireless network name or service set identifier (SSID).

● Determine the security password or encryption key for the wireless network.

Connect the product to a wireless network using WPS

If your wireless router supports Wi-Fi Protected Setup (WPS), this is the simplest way to set up the product on 
a wireless network.

1. Press the WPS button on your wireless router.

2. Press and hold the Wireless  button on the product control panel for two seconds. Release the button 
when the wireless light starts blinking.

3. Wait up to two minutes while the product establishes a network connection with the wireless router.

NOTE: If this method is not successful, try using the wireless network using USB cable method.

Connect the product to a wireless network using a USB cable

If your wireless router does not support WiFi-Protected Setup (WPS), use this method to set up the product on 
a wireless network. Using a USB cable to transfer settings makes setting up a wireless connection easier. After 
the setup is complete, you can disconnect the USB cable and use the wireless connection.

1. Insert the software CD into the computer CD tray.

2. Follow the on-screen instructions. When prompted, select the Connect through a wireless network 
option. Connect the USB cable to the product when prompted.

CAUTION: Do not connect the USB cable until the installation program prompts you.

3. When the installation is complete, print a configuration page to make sure that the product has a SSID 
name.

4. When installation is complete, disconnect the USB cable.

Remove software from Mac operating systems

You must have administrator rights to remove the software.

1. Disconnect the product from the computer.

2. Open Applications.

3. Select HP.

4. Select HP Uninstaller.

5. Select the product from the list of devices, and then click the Uninstall button.

6. After the software is uninstalled, restart the computer and empty the Trash.
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Change printer-driver settings for Mac

Change the settings for all print jobs 
until the software program is closed

Change the default settings for all print 
jobs

Change the product configuration 
settings

1. On the File menu, click the Print 
button.

2. Change the settings that you want on 
the various menus.

1. On the File menu, click the Print 
button.

2. Change the settings that you want on 
the various menus.

3. On the Presets menu, click the Save 
As... option and type a name for the 
preset.

These settings are saved in the Presets 
menu. To use the new settings, you must 
select the saved preset option every time 
you open a program and print.

Mac OS X 10.5 and 10.6

1. From the Apple menu , click the 

System Preferences menu and then 
click the Print & Fax icon.

2. Select the product in the left side of 
the window.

3. Click the Options & Supplies button.

4. Click the Driver tab.

5. Configure the installed options.
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Software for Mac computers

Supported utilities for Mac (network models only)

HP Utility for Mac

Use the HP Utility to set up product features that are not available in the printer driver.

You can use the HP Utility when the product uses a universal serial bus (USB) cable or is connected to a 
TCP/IP-based network.

Open the HP Utility

▲ From the dock, click HP Utility.

-or-

From Applications, click HP, and then click HP Utility.

HP Utility features

Use the HP Utility software to perform the following tasks:

● Obtain information about supplies status.

● Obtain information about the product, such as the firmware version and the serial number.

● Print a configuration page.

● For products connected to an IP-based network, obtain network information and open the HP Embedded 
Web Server.

● Configure the paper type and size for the tray.

● Transfer files and fonts from the computer to the product.

● Update the product firmware.

● Display the color usage page.

Supported utilities for Mac

HP Embedded Web Server

The product is equipped with an embedded Web server, which provides access to information about product 
and network activities.
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Print with Mac

Cancel a print job with Mac

1. If the print job is currently printing, cancel it by pressing the Cancel  button on the product control 
panel.

NOTE: Pressing the Cancel  button clears the job that the product is currently processing. If more 
than one process is running, pressing the Cancel  button clears the process that currently appears on 
the product control panel.

2. You can also cancel a print job from a software program or a print queue.

● Software program: Typically, a dialog box appears briefly on the computer screen, allowing you to 
cancel the print job.

● Mac print queue: Open the print queue by double-clicking the product icon in the dock. Highlight 
the print job, and then click Delete.

Change the paper size and type with Mac

1. On the File menu in the software program, click the Print option.

2. In the Copies & Pages menu, click the Page Setup button.

3. Select a size from the Paper Size drop-down list, and then click the OK button.

4. Open the Finishing menu.

5. Select a type from the Media-type drop-down list.

6. Click the Print button.

Resize documents or print on a custom paper size with Mac

Mac OS X 10.5 and 10.6

Use one of these methods.

1. On the File menu, click the Print option.

2. Click the Page Setup button.

3. Select the product, and then select the correct settings for the Paper Size and 
Orientation options.

1. On the File menu, click the Print option.

2. Open the Paper Handling menu.

3. In the Destination Paper Size area, click the Scale to fit paper size box, and then 
select the size from the drop-down list.

Create and use printing presets with Mac

Use printing presets to save the current printer driver settings for reuse.
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Create a printing preset

1. On the File menu, click the Print option.

2. Select the driver.

3. Select the print settings that you want to save for reuse.

4. In the Presets menu, click the Save As... option, and type a name for the preset.

5. Click the OK button.

Use printing presets

1. On the File menu, click the Print option.

2. Select the driver.

3. In the Presets menu, select the printing preset.

NOTE: To use printer-driver default settings, select the standard option.

Print a cover page with Mac

1. On the File menu, click the Print option.

2. Select the driver.

3. Open the Cover Page menu, and then select where to print the cover page. Click either the Before 
Document button or the After Document button.

4. In the Cover Page Type menu, select the message that you want to print on the cover page.

NOTE: To print a blank cover page, select the standard option from the Cover Page Type menu.

Print multiple pages on one sheet of paper with Mac

1. On the File menu, click the Print option.

2. Select the driver.

3. Open the Layout menu.
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4. From the Pages per Sheet menu, select the number of pages that you want to print on each sheet (1, 2, 
4, 6, 9, or 16).

5. In the Layout Direction area, select the order and placement of the pages on the sheet.

6. From the Borders menu, select the type of border to print around each page on the sheet.

Print on both sides of the page (duplex) with Mac

1. Insert enough paper into one of the trays to accommodate the print job.

2. On the File menu, click the Print option.

3. Open the Layout menu, and click the Manual Duplex tab or open the Manual Duplex menu.

4. Click the Manual Duplex box, and select a binding option.

5. Click the Print button. Follow the instructions in the pop-up window that appears on the computer 
screen before replacing the output stack in Tray 1 for printing the second half.

6. Go to the product, and remove any blank paper that is in Tray 1.

7. Retrieve the printed stack from the output bin, and, maintaining the paper orientation, place it with the 
printed-side facing down in the input tray.

8. At the computer, click the Continue button to print the second side of the job. If at the product, press the 
Resume  button.

Set the color options with Mac

Use the Color Options menu or the Color/Quality Options menu to control how colors are interpreted and 
printed from software programs.

1. On the File menu, click the Print option.

2. Select the driver.

3. Open the Color Options menu or the Color/Quality Options menu.

4. Open the Advanced menu, or select the appropriate tab.

5. Adjust the individual settings for text, graphics, and photographs.
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4 Connect the product

● Supported network operating systems (network models only) 

● Connect with USB

● Connect to a network (network models only)
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Supported network operating systems (network models only) 
The product supports the following operating systems for wireless printing:

● Windows 7 (32-bit and 64-bit)

● Windows Vista (32-bit and 64-bit)

● Windows XP (32-bit, Service Pack 2)

● Windows Server 2003 (32-bit, Service Pack 3)

● Windows Server 2008 (32-bit and 64-bit)

● Mac OS X v10.5 and v10.6

Printer sharing disclaimer

HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating systems and 
not of the HP printer drivers. Go to Microsoft at www.microsoft.com.
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Connect with USB
This product supports a USB 2.0 connection. Use an A-to-B type USB cable. HP recommends using a cable that 
is no longer than 2 m (6.5 ft).

CAUTION: Do not connect the USB cable until the installation software prompts you to connect it.

CD installation

1. Quit all open programs on the computer.

2. Install the software from the CD, and follow the onscreen instructions.

3. When prompted, select the Directly connect to this computer using a USB cable option, and then click 
the Next button.

4. When the software prompts you, connect the USB cable to the product and the computer.

5. At the end of the installation, click the Finish button.

6. On the More Options screen, you can install more software, or click the Finish button.

7. Print a page from any program to make sure that the printing software is correctly installed.
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Connect to a network (network models only)
The product can connect to wired or wireless networks.

NOTE: You cannot connect to a wired and wireless network simultaneously. Wired connections take 
precedence.

Supported network protocols

To connect a networking-equipped product to a network, you need a network that uses one of the following 
protocols.

● TCP/IP (IPv4 or IPv6)

● Port 9100

● LPR

● DHCP

● AutoIP

● SNMP

● Bonjour

● SLP

● WSD

● NBNS

Install the product on a wired network

Configure the IP address

1. Connect the network cable to the product and to the network.

2. Wait for 60 seconds before continuing. During this time, the network recognizes the product and assigns 
an IP address or host name for the product.
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3. Press and hold the Resume  button for two to three seconds to print a configuration page and a 
supplies status page.

4. Find the IP address on the configuration report.

LASERJET PROFESSIONAL 

Install the software

1. Quit all programs on the computer.

2. Install the software from the CD.

3. Follow the onscreen instructions.

4. When prompted, select the Connect through a wired network option, and then click the Next button.

5. From the list of available printers, select the printer that has the correct IP address.

6. Click the Finish button.

7. On the More Options screen, you can install more software, or click the Finish button.

8. Print a page from any program to make sure that the printing software is correctly installed.

Install the product on a wireless network 

Before installing the product software, make sure the product is not connected to the network using a 
network cable.

If your wireless router does not support Wi-Fi Protected Setup (WPS), obtain the wireless router network 
settings from your system administrator, or complete the following tasks:

● Obtain the wireless network name or service set identifier (SSID).

● Determine the security password or encryption key for the wireless network.

Connect the product to a wireless network using WPS

If your wireless router supports Wi-Fi Protected Setup (WPS), this is the simplest way to set up the product on 
a wireless network.

1. Press the WPS button on your wireless router.

2. Press and hold the Wireless  button on the product control panel for two seconds. Release the button 
when the wireless light starts blinking.

3. Wait up to two minutes while the product establishes a network connection with the wireless router.
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NOTE: If this method is not successful, try using the wireless network setup using the USB cable method.

Connect the product to a wireless network using a USB cable

If your wireless router does not support WiFi-Protected Setup (WPS), use this method to set up the product on 
a wireless network. Using a USB cable to transfer settings makes setting up a wireless connection easier. After 
the setup is complete, you can disconnect the USB cable and use the wireless connection.

1. Insert the software CD into the computer CD tray.

2. Follow the on-screen instructions. When prompted, select the Connect through a wireless network 
option. Connect the USB cable to the product when prompted.

CAUTION: Do not connect the USB cable until the installation program prompts you.

3. When the installation is complete, print a configuration page to make sure that the product has a SSID 
name.

4. When installation is complete, disconnect the USB cable.

Install the software for a wireless product currently on the network

If the product already has an IP address on a wireless network and you want to install product software on a 
computer, complete the following steps.

1. From the product control panel, print a configuration page to obtain the product IP address.

2. Install the software from the CD.

3. Follow the on-screen instructions.

4. When prompted, select the Connect through a wireless network option, and then click the Next button.

5. From the list of available printers, select the printer that has the correct IP address.

Disconnect from the wireless network

If you want to disconnect the product from a wireless network, you can turn off the wireless unit in the 
product.

1. At the product control panel, press and release the Wireless  button.

2. To confirm that the wireless unit is turned off, print a configuration page and then verify that the status 
is specified as disabled on the configuration page.

Reduce interference on a wireless network

The following tips can reduce interference in a wireless network:

● Keep the wireless devices away from large metal objects, such as filing cabinets, and other 
electromagnetic devices, such as microwaves and cordless telephones. These objects can disrupt radio 
signals.

● Keep the wireless devices away from large masonry structures and other building structures. These 
objects can absorb radio waves and lower signal strength.

● Position the wireless router in a central location in line of sight with the wireless products on the 
network.
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Advanced wireless setup

Wireless communication modes

You can use one of two wireless communication modes: infrastructure or ad-hoc.

Infrastructure wireless network 
(recommended)

The product communicates with other devices on the network through a wireless router.

Ad-hoc wireless network The product communicates directly with other wireless devices without using a wireless router.

All devices on the ad hoc network must have the following:

● 802.11b/g compatibility

● The same SSID

● The same subnet and channel

● The same 802.11b/g security settings

Wireless security

To make your wireless network easy to distinguish from other wireless networks, use a unique network name 
(SSID) for your wireless router. Your wireless router might have a default network name, which is typically the 
manufacturer's name. For information on how to change the network name, see the documentation that 
came with the wireless router.
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To prevent other users from accessing your network, turn on WPA or WEP data encryption.

● Wired Equivalent Privacy (WEP): WEP is the original native security mechanism in the 802.11 standard. 
You create a unique key containing hexadecimal or alphanumeric characters, which other users must 
provide before they can access your network.

● Wi-Fi Protected Access (WPA): WPA uses the temporal key integrity protocol (TKIP) for encryption and 
employs 802.1X authentication. It addresses all known weaknesses of WEP. You create a unique 
passphrase containing a combination of letters and numbers, which other users must provide before 
they can access your network.

● WPA2 provides the advanced encryption standard (AES), and is an improvement over WPA.

Install the product on an ad-hoc wireless network

You can connect the product wirelessly to a computer through a peer-to-peer (ad-hoc) installation.

NOTE: To accomplish this task, you must temporarily connect the product to the network by using a 
network cable.

1. Connect the network cable to the product and to the network.

2. Wait for 60 seconds before continuing. During this time, the network recognizes the product and assigns 
an IP address or host name for the product.

3. Press and hold the Resume  button for two to three seconds to print a configuration page and a 
supplies status page.

4. Find the IP address on the configuration page.

5. Open a Web browser, and type the IP address into the address line. The HP Embedded Web Server 
opens.

6. Click the Networking tab, and select the Wireless Configuration link from the left pane.

7. Select the option to enable wireless networking, and then disconnect the network cable.

8. In the Configuration Method area, select the Create a new Ad hoc wireless network (peer-to-peer) 
option.

9. Provide a unique network name, select a channel, and select the type of security to use.

10. Click the Apply button.

Configure network settings

View or change network settings

Use the embedded Web server to view or change IP configuration settings.

1. Print a configuration page, and locate the IP address.

● If you are using IPv4, the IP address contains only digits. It has this format:

xxx.xxx.xxx.xxx

● If you are using IPv6, the IP address is a hexadecimal combination of characters and digits. It has a 
format similar to this:
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xxxx::xxxx:xxxx:xxxx:xxxx

2. To open the HP Embedded Web Server, type the IP address (IPv4) into the address line of a Web browser. 
For IPv6, use the protocol established by the Web browser for entering IPv6 addresses.

3. Click the Networking tab to obtain network information. You can change settings as needed.
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5 Paper and print media

● Understand paper use

● Change the printer driver to match the paper type and size

● Supported paper sizes

● Supported paper types

● Load paper trays
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Understand paper use
This product supports a variety of paper and other print media in accordance with the guidelines in this user 
guide. Paper or print media that does not meet these guidelines might cause poor print quality, increased 
jams, and premature wear on the product.

For best results, use only HP-brand paper and print media designed for laser printers or multiuse. Do not use 
paper or print media made for inkjet printers. HP Company cannot recommend the use of other brands of 
media because HP cannot control their quality.

It is possible for paper to meet all of the guidelines in this user guide and still not produce satisfactory results. 
This might be the result of improper handling, unacceptable temperature and/or humidity levels, or other 
variables over which HP has no control.

CAUTION: Using paper or print media that does not meet HP's specifications might cause problems for the 
product, requiring repair. This repair is not covered by the HP warranty or service agreements.

Special paper guidelines

This product supports printing on special media. Use the following guidelines to obtain satisfactory results. 
When using special paper or print media, be sure to set the type and size in the printer driver to obtain the 
best results.

CAUTION: HP LaserJet products use fusers to bond dry toner particles to the paper in very precise dots. HP 
laser paper is designed to withstand this extreme heat. Using inkjet paper could damage the product.

Media type Do Do not

Envelopes ● Store envelopes flat.

● Use envelopes where the seam 
extends all the way to the corner of 
the envelope.

● Use peel-off adhesive strips that are 
approved for use in laser printers.

● Do not use envelopes that are 
wrinkled, nicked, stuck together, or 
otherwise damaged.

● Do not use envelopes that have 
clasps, snaps, windows, or coated 
linings.

● Do not use self-stick adhesives or 
other synthetic materials.

Labels ● Use only labels that have no exposed 
backing between them.

● Use labels that lie flat.

● Use only full sheets of labels.

● Do not use labels that have wrinkles 
or bubbles, or are damaged.

● Do not print partial sheets of labels.

Transparencies ● Use only transparencies that are 
approved for use in color laser 
printers.

● Place transparencies on a flat surface 
after removing them from the 
product.

● Do not use transparent print media 
not approved for laser printers.

Letterhead or preprinted forms ● Use only letterhead or forms 
approved for use in laser printers.

● Do not use raised or metallic 
letterhead.
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Media type Do Do not

Heavy paper ● Use only heavy paper that is 
approved for use in laser printers and 
meets the weight specifications for 
this product.

● Do not use paper that is heavier than 
the recommended media 
specification for this product unless it 
is HP paper that has been approved 
for use in this product.

Glossy or coated paper ● Use only glossy or coated paper that 
is approved for use in laser printers.

● Do not use glossy or coated paper 
designed for use in inkjet products.
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Change the printer driver to match the paper type and size
NOTE: If you change the page settings in the software program, those settings override any settings in the 
printer driver.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a size from the Size is drop-down list.

5. Select a paper type from the Type is drop-down list.

6. Click the OK button.
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Supported paper sizes
This product supports various paper sizes, and it adapts to various media.

NOTE: To obtain best print results, select the appropriate paper size and type in your print driver before 
printing.

Table 5-1  Supported paper and print media sizes

Size Dimensions

Letter 216 x 279 mm (8.5 x 11 in)

Legal 216 x 356 mm (8.5 x 14 in)

A4 210 x 297 mm (8.27 x 11.69 in)

Executive 184 x 267 mm (7.25 x 10.5 in)

8.5 x 13 216 x 330 mm (8.5 x 13 in)

4 x 6 101.6 x 152.4 mm (4 x 6 in)

10 x 15 cm 101.6 x 152.4 mm (4 x 6 in)

5 x 8 127 x 203 mm (5 x 8 in)

RA4 215 x 305 mm (8.46 x 12.01 in)

A5 148 x 210 mm (5.83 x 8.27 in)

A6 105 x 148 mm (4.13 x 5.83 in)

B5 (JIS) 182 x 257 mm (7.17 x 10.12 in)

16k 184 x 260 mm (7.24 x 10.23 in)

195 x 270 mm (7.68 x 10.62 in)

197 x 273 mm (7.75 x 10.75 in)

Custom Minimum: 76 x 127 mm (3 x 5 in)

Maximum: 216 x 356 mm (8.5 x 14.0 in)

NOTE: When defining custom sizes using the printer driver, always specify the short edge of 
the page as the width and the long edge as the length.

Table 5-2  Supported envelopes and postcards

Size Dimensions

Envelope #10 105 x 241 mm (4.13 x 9.49 in)

Envelope DL 110 x 220 mm (4.33 x 8.66 in)

Envelope C5 162 x 229 mm (6.93 x 9.84 in)

Envelope B5 176 x 250 mm (6.7 x 9.8 in)

Envelope Monarch 98 x 191 mm (3.9 x 7.5 in)

Japanese Postcard

Postcard (JIS)

100 x 148 mm (3.93 x 5.82 in)
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Table 5-2  Supported envelopes and postcards (continued)

Size Dimensions

Double Japan Postcard Rotated

Double Postcard (JIS)

148 x 200 mm (5.83 x 7.87 in)

Custom Minimum: 76 x 127 mm (3 x 5 in)

Maximum: 216 x 356 mm (8.5 x 14.0 in)

NOTE: When defining custom sizes using the printer driver, always specify the short edge of 
the page as the width and the long edge as the length.
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Supported paper types
For a complete list of specific HP-brand paper that this product supports, go to www.hp.com/support/
ljcp1020series.

● Everyday

◦ Plain

◦ Light

◦ Bond

◦ Recycled

● Presentation

◦ Matte paper

◦ Glossy paper

◦ Heavy paper

◦ Heavy glossy paper

● Brochure

◦ Matte paper

◦ Glossy paper

◦ Tri-fold paper

◦ Extra heavy paper

◦ Extra heavy glossy paper

● Photo/Cover

◦ Matte cover paper

◦ Matte photo paper

◦ Photo glossy paper

◦ Glossy cards

● Other

◦ Color laser transparency

◦ Labels

◦ Letterhead

◦ Envelope

◦ Heavy envelope

◦ Preprinted

◦ Prepunched
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◦ Colored

◦ Rough

◦ Heavy rough

◦ HP Tough paper
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Load paper trays

Load the input tray

NOTE: When you add new paper make sure that you remove all of the paper from the input tray and 
straighten the stack of new paper. Do not fan the paper. This reduces jams by preventing multiple sheets of 
paper from feeding through the product at one time.

NOTE: When printing on small sizes or custom paper, load the short edge (width) into the product first.

1. Load the paper face-up, top forward in the input 
tray.

 

2. Adjust the guides until they are snug against the 
paper.

 

Tray capacity

Tray or bin Paper type Specifications Capacity

Input tray Paper 60-220 g/m2 (16-59 lb)

Print quality is assured for HP 
media.

150 sheets of 75 g/m2 (20 lb)
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Tray or bin Paper type Specifications Capacity

Envelopes 60-90 g/m2 (16-24 lb) Up to 10 envelopes

Transparencies 0.12-0.13 mm (0.0047-.0.0051 in) Up to 50 transparencies

Postcards 135-176 g/m2 (36-47 lb)

Glossy 130-220 g/m2 ()

Paper orientation for loading trays

If you are using paper that requires a specific orientation, load it according to the information in the following 
table.

Paper type How to load paper

Preprinted or letterhead ● Face up

● Top edge leading into the product

Prepunched ● Face up

● Holes toward the left side of the product

Envelope ● Face up

● Right short edge leading into the product
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6 Print tasks

● Cancel a print job with Windows

● Basic print tasks with Windows

● Additional print tasks with Windows
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Cancel a print job with Windows
1. If the print job is currently printing, cancel it by pressing the Cancel  button on the product control 

panel.

NOTE: Pressing the Cancel  button clears the job that the product is currently processing. If more 
than one process is running, pressing the Cancel  button clears the process that currently appears on 
the product control panel.

2. You can also cancel a print job from a software program or a print queue.

● Software program: Typically, a dialog box appears briefly on the computer screen, allowing you to 
cancel the print job.

● Windows print queue: If a print job is waiting in a print queue (computer memory) or print spooler, 
delete the job there.

◦ Windows XP, Server 2003, or Server 2008: Click Start, click Settings, and then click Printers 
and Faxes. Double-click the product icon to open the window, right-click the print job that 
you want to cancel, and then click Cancel.

◦ Windows Vista: Click Start, click Control Panel, and then, under Hardware and Sound, click 
Printer. Double-click the product icon to open the window, right-click the print job that you 
want to cancel, and then click Cancel.

◦ Windows 7: Click Start, and then click Devices and Printers. Double-click the product icon to 
open the window, right-click the print job that you want to cancel, and then click Cancel.
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Basic print tasks with Windows
The methods to open the print dialog from software programs can vary. The procedures that follow include a 
typical method. Some software programs do not have a File menu. See the documentation for your software 
program to learn how to open the print dialog.

Open the printer driver with Windows

1. On the File menu in the software program, click 
Print.

 

2. Select the product, and then click the Properties 
or Preferences button.
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Get help for any printing option with Windows

1. Click the Help button to open the online Help.  
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Change the number of print copies with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then select the number of copies.

Save custom print settings for reuse with Windows

Use a printing shortcut with Windows

1. On the File menu in the software program, click 
Print.

 

2. Select the product, and then click the Properties 
or Preferences button.
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3. Click the Printing Shortcuts tab.  

4. Select one of the shortcuts, and then click the OK 
button.

NOTE: When you select a shortcut, the 
corresponding settings change on the other tabs 
in the printer driver.

 

Create printing shortcuts

1. On the File menu in the software program, click 
Print.
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2. Select the product, and then click the Properties 
or Preferences button.

 

3. Click the Printing Shortcuts tab.  

4. Select an existing shortcut as a base.

NOTE: Always select a shortcut before adjusting 
any of the settings on the right side of the screen. 
If you adjust the settings and then select a 
shortcut, or if you select a different shortcut, all 
your adjustments are lost.
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5. Select the print options for the new shortcut.

NOTE: You can select the print options on this 
tab or on any other tab in the printer driver. After 
selecting options on other tabs, return to the 
Printing Shortcuts tab before continuing with 
the next step.

 

6. Click the Save As button.  

7. Type a name for the shortcut, and click the OK 
button.

 

Improve print quality with Windows

Select the page size with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a size from the Size is drop-down list.
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Select a custom page size with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the Custom button.

5. Type a name for the custom size and specify the dimensions.

● The width is the short edge of the paper.

● The length is the long edge of the paper.

NOTE: Always load paper into the trays short edge first.

6. Click the Save button, and then click the Close button.

Select the paper type with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Type is drop-down list, click the More... option.

5. Select the category of paper types that best describes your paper, and then click the paper type that you 
are using.

Print on both sides (duplex) with Windows

Print on both sides manually

1. Load paper face-up in the input tray.  
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2. On the File menu in the software program, click 
Print.

 

3. Select the product, and then click the Properties 
or Preferences button.

 

4. Click the Finishing tab.  
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5. Select the Print on Both Sides (Manually) check 
box. Click the OK button to print the first side of 
the job.

 

6. Retrieve the printed stack from the output bin, 
and, maintaining the paper orientation, place it 
with the printed-side facing down in the input 
tray.

 

7. At the computer, click the Continue button to 
print the second side of the job. If at the product, 
press the Resume  button.

 

Print multiple pages per sheet with Windows

1. On the File menu in the software program, click 
Print.
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2. Select the product, and then click the Properties 
or Preferences button.

 

3. Click the Finishing tab.  
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4. Select the number of pages per sheet from the 
Pages Per Sheet drop-down list.

 

5. Select the correct Print Page Borders, Page 
Order, and Orientation options.

 

Select page orientation with Windows

1. On the File menu in the software program, click 
Print.
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2. Select the product, and then click the Properties 
or Preferences button.

 

3. Click the Finishing tab.  

4. In the Orientation area, select the Portrait or 
Landscape option.

To print the page image upside down, select the 
Rotated option.
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Set color options with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Color tab.

4. In the Color Options area, click the Manual option, and then click the Settings button.

5. Adjust the general settings for Edge Control, and settings for text, graphics, and photographs.
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Additional print tasks with Windows

Print colored text as black (grayscale) with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the Print all Text as Black check box. Click the OK button.
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Print on preprinted letterhead or forms with Windows

1. On the File menu in the software program, click 
Print.

 

2. Select the product, and then click the Properties 
or Preferences button.

 

3. Click the Paper/Quality tab.  
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4. From the Type is drop-down list, click the More... 
option.

 

5. Select the Other option.  

6. Select the option for the type of paper you are 
using, and click the OK button.
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Print on special paper, labels, or transparencies with Windows

1. On the File menu in the software program, click 
Print.

 

2. Select the product, and then click the Properties 
or Preferences button.

 

3. Click the Paper/Quality tab.  
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4. From the Type is drop-down list, click the More... 
option.

 

5. Select the category of paper types that best 
describes your paper.

NOTE: Labels and transparencies are in the list 
of Other options.

 

6. Select the option for the type of paper you are 
using, and click the OK button.
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Print the first or last page on different paper with Windows

1. On the File menu in the software program, click 
Print.

 

2. Select the product, and then click the Properties 
or Preferences button.
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3. Click the Paper/Quality tab.  

4. Click the Use different paper check box, and then 
select the necessary settings for the front cover, 
other pages, and back cover.

 

Scale a document to fit page size with Windows

1. On the File menu in the software program, click 
Print.
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2. Select the product, and then click the Properties 
or Preferences button.

 

3. Click the Effects tab.  

4. Select the Print Document On option, and then 
select a size from the drop-down list.
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Add a watermark to a document with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Effects tab.

4. Select a watermark from the Watermarks drop-down list.

Or, to add a new watermark to the list, click the Edit button. Specify the settings for the watermark, and 
then click the OK button.

5. To print the watermark on the first page only, select the First Page Only check box. Otherwise, the 
watermark is printed on each page.

Create a booklet with Windows

1. On the File menu in the software program, click 
Print.

 

2. Select the product, and then click the Properties 
or Preferences button.
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3. Click the Finishing tab.  

4. Click the Print on Both Sides (Manually) check 
box.

 

5. In the Booklet Printing drop-down list, select a 
binding option. The Pages Per Sheet option 
automatically changes to 2 Pages Per Sheet.
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7 Color

● Adjust color

● Match colors
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Adjust color
Manage color by changing the settings on the Color tab in the printer driver.

Change the color theme for a print job

1. On the File menu in the software program, click Print.

2. Click Properties or Preferences.

3. Click the Color tab.

4. Select a color theme from the Color Themes drop-down list.

● Default (sRGB): This theme sets the product to print RGB data in raw device mode. When using this 
theme, manage color in the software program or in the operating system for correct rendering.

● Vivid: The product increases the color saturation in the midtones. Use this theme when printing 
business graphics.

● Photo: The product interprets RGB color as if it were printed as a photograph using a digital mini 
lab. The product renders deeper, more saturated colors differently than with the Default (sRBG) 
theme. Use this theme when printing photos.

● Photo (Adobe RGB 1998): Use this theme with printing digital photos that use the AdobeRGB color 
space rather than sRGB. Turn off color management in the software program when using this 
theme.

● None: No color theme is used.

Change the color options

Change the color options settings for the current print job from the color tab of the printer driver.

1. On the File menu in the software program, click Print.

2. Click Properties or Preferences.

3. Click the Color tab.

4. Click the Automatic or Manual setting.
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● Automatic setting: Select this setting for most color print jobs

● Manual setting: Select this setting to adjust the color settings independent from other settings.

NOTE: Changing color settings manually can impact output. HP recommends that only color 
graphics experts change these settings.

5. Click the Print in Grayscale option to print a color document in black and shades of gray. Use this option 
to print color documents for photocopying or faxing. You can also use this option to print draft copies or 
to save color toner.

6. Click the OK button.

Manual color options

Use manual color options to adjust the Neutral Grays, Halftone, and Edge Control options for text, graphics, 
and photographs.

Table 7-1  Manual color options

Setting description Setting options

Edge Control

The Edge Control setting determines the rendering of 
edges. Edge control has two components: adaptive 
halftoning and trapping. Adaptive halftoning increases 
edge sharpness. Trapping reduces the effect of color-
plane misregistration by overlapping the edges of 
adjacent objects slightly.

● Off turns off both trapping and adaptive halftoning.

● Light sets trapping at a minimal level. Adaptive halftoning is on.

● Normal sets trapping at a medium level. Adaptive halftoning is on.

● Maximum is the most aggressive trapping setting. Adaptive 
halftoning is on.
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Table 7-1  Manual color options (continued)

Setting description Setting options

Halftone

Halftone options affect color output clarity and 
resolution.

● Smooth provides better results for large, solid-filled print areas and 
enhances photographs by smoothing color gradations. Select this 
option when uniform and smooth area fills are important.

● Detail is useful for text and graphics that require sharp distinctions 
among lines or colors, or images that contain a pattern or a high level 
of detail. Select this option when sharp edges and small details are 
important.

Neutral Grays

The Neutral Grays setting determines the method for 
creating gray colors used in text, graphics, and 
photographs.

● Black Only generates neutral colors (grays and black) by using only 
black toner. This guarantees neutral colors without a color cast. This 
setting is best for documents and grayscale viewgraphs.

● 4-Color generates neutral colors (grays and black) by combining all 
four toner colors. This method produces smoother gradients and 
transitions to other colors, and it produces the darkest black.
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Match colors
For most users, the best method for matching colors is to print sRGB colors.

The process of matching printer output color to your computer screen is complex, because printers and 
computer monitors use different methods of producing color. Monitors display colors by using light pixels that 
use an RGB (red, green, blue) color process, but printers print colors by using a CMYK (cyan, magenta, yellow, 
and black) process.

Several factors can influence your ability to match printed colors to those on your monitor:

● Print media

● Printer colorants (inks or toners, for example)

● Printing process (inkjet, press, or laser technology, for example)

● Overhead lighting

● Personal differences in perception of color

● Software programs

● Printer drivers

● Computer operating systems

● Monitors

● Video cards and drivers

● Operating environment (humidity, for example)

Keep these factors in mind when colors on your screen do not perfectly match your printed colors.
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8 Manage and maintain the product

● Print information pages

● Use the HP Embedded Web Server (network models only) 

● Product security features

● Economy settings

● Manage supplies and accessories

● Clean the product

● Product updates
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Print information pages
You can print the following information pages.

Page Description

Configuration page Prints a list of the product settings

Supplies Status page The supplies status page includes the following information:

● Approximate percentage of print cartridge life remaining

● Warranty status of print cartridges and imaging drum

● Part numbers for HP print cartridges

● Number of pages printed

● Information about ordering new HP print cartridges and 
recycling used HP print cartridges

● The imaging drum's estimated life remaining and 
installation date display if less than 30% of its estimated life 
remains.

Print the configuration page

The configuration page lists current product settings and properties. This page also contains a status log 
report. To print a configuration page, do one of the following:

● Select Print configuration page on the Services tab in the Printer Preferences.

● Press and hold the Resume  button for two to three seconds to print a configuration page and a 
supplies status page (English only).

Print the supplies status page

To print a supplies status page, do one of the following:

● Select Print supplies status page on the Services tab in the Printer Preferences.

● Press and hold the Resume  button for two to three seconds to print a configuration page and a 
supplies status page (English only).
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Use the HP Embedded Web Server (network models only) 
This product is equipped with an embedded Web server (EWS), which provides access to information about 
product and network activities. A Web server provides an environment in which web programs may run, much 
in the same way that an operating system, such as Windows, provides an environment for programs to run on 
a computer. The output from these programs can then be displayed by a Web browser, such as Microsoft 
Internet Explorer, Safari, or Netscape Navigator.

An “embedded” Web server resides on a hardware device (such as an HP LaserJet product) or in firmware, 
rather than as software that is loaded on a network server.

The advantage of an EWS is that it provides an interface to the product that anyone with a network-connected 
product and computer can use. There is no special software to install or configure, but you must have a 
supported Web browser on the computer. To gain access to the EWS, type the IP address for the product in the 
address line of the browser. To find the IP address, print a configuration page.

NOTE: For Mac operating systems, you can use the EWS over a USB connection after installing the Mac 
software included with the product.

Open the HP Embedded Web Server

To open the HP Embedded Web Server, type the IP address or host name of the product in the address field of 
a supported Web browser. To find the IP address, print a configuration page. Select Print configuration page 
on the Services tab in the Printer Preferences.

TIP: After you open the URL, bookmark it so that you can return to it quickly in the future.

HP Embedded Web Server features

The table below describes the basic screens of the embedded Web server.
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Tab or section Description

Status tab

Provides product, status, and 
configuration information.

● Device Status: Shows the product status and shows the life remaining of HP supplies, 
with 0% indicating that a supply is empty.

● Supplies Status: Shows the approximate percent life remaining of HP supplies. When the 
estimated life remaining is less than 10% but has not reached the estimated end of life, 
Less Than 10% displays. When a supply reaches its estimated end of life –% displays. 
Actual supply life remaining can vary. Consider having a replacement supply available to 
install when print quality is no longer acceptable. The supply does not need to be 
replaced unless the print quality is no longer acceptable. When an HP supply has reached 
“Very Low”, HP’s Premium Protection Warranty on that supply ends.

The imaging drum's estimated remaining life and installation date displays when less 
than approximately 30% of its estimated life remains.

● Device Configuration: Shows the information found on the product Configuration page.

● Network Summary: Shows the information found on the product Network Configuration 
page.

● Reports: Allows you to print the configuration and supplies status pages that the product 
generates.

● Event Log: Shows a list of all product events and errors.

● Support button: Provides a link to the product support page. The Support button can be 
password-protected.

● Shop for Supplies button: Provides a link to a page where you can order supplies for the 
product. The Shop for Supplies button can be password-protected.

System tab

Provides the ability to configure the 
product from your computer.

● Paper Setup: Allows you to change the paper-handling defaults for the product.

● Print Quality: Allows you to change the print quality defaults for the product, including 
calibration settings.

● Print Density: Allows you to change the contrasts, highlights, midtones, and shadows 
values for each supply.

● Paper Types: Allows you to configure print modes that correspond to the media types 
that the product accepts.

● System Setup: Allows you to change the system defaults for the product.

● Service: Allows you to start the cleaning procedure on the product.

● Product Security: Allows you to set or change the Administrator password.

● Support button: Provides a link to the product support page. The Support button can be 
password-protected.

● Shop for Supplies button: Provides a link to a page where you can order supplies for the 
product. The Shop for Supplies button can be password-protected.

NOTE: The System tab can be password-protected. If this product is on a network, always 
consult with the printer administrator before changing settings on this tab.

Networking tab

Provides the ability to change 
network settings from your 
computer.

Network administrators can use this tab to control network-related settings for the product 
when it is connected to an IP-based network. This tab does not appear if the product is directly 
connected to a computer.
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Product security features
The product supports security standards and recommended protocols that help you keep the product secure, 
protect critical information on your network, and simplify the way you monitor and maintain the product.

For in-depth information about HP's secure imaging and printing solutions, visit www.hp.com/go/
secureprinting. The site provides links to white papers and FAQ documents about security features.

Lock the product

1. You can attach a security cable to the slot on the 
back of the product.

 

Assign a system password

Assign a password for the product so that unauthorized users cannot change the product settings.

1. Open the HP Embedded Web Server by entering the product IP address into the address line of a Web 
browser.

2. Click the System tab.

3. On the left side of the window, click the Product Security menu.

4. Type the password in the Password box, and type it again in the Confirm Password box.

5. Click the Apply button. Make note of the password and store it in a safe place.
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Economy settings

Set Auto-On/Auto-Off mode

Auto-On\Auto-Off is an energy-saving feature of this product. After a user-specified time period, the product 
automatically reduces its power consumption. The product returns to the ready state when a button is 
pressed or a print job is received.

NOTE: Although the product lights are off in Auto-Off mode, the product will work normally when it receives 
a print job.

Change the Auto-On\Auto-Off setting

You can change how long the product remains idle (Auto-Off delay) before it enters Auto-Off mode. You can 
also select which events cause the product to turn on.

1. In the Windows system tray, right-click the Device Settings  icon and then click the product name.

2. Click the Device Settings button.

3. Click the AutoOFF after delay button, and then select the Auto-Off delay from the drop-down list.

4. Under AutoON to these events click the desired events (optional).

80 Chapter 8   Manage and maintain the product ENWW



Manage supplies and accessories
Correctly using, storing, and monitoring the print cartridge and imaging drum can help ensure high-quality 
print output.

Print when a print cartridge or imaging drum is at estimated end of life

Supplies messages

<Supply> Low message—where <Supply> is the color print cartridge: The product indicates when a supply 
level is low. Actual print cartridge life remaining may vary. Consider having a replacement available to install 
when print quality is no longer acceptable. The supply does not need to be replaced now. This alert appears 
only when <Supply> Very Low is set to Stop.

<Supply> Very Low message—where <Supply> is either the color print cartridge or imaging drum or a 
combination of multiple print cartridges and/or the imaging drum: The product indicates when a supply level 
is very low. Actual print cartridge life remaining may vary. Consider having a replacement available to install 
when print quality is no longer acceptable. Print-quality problems may occur when using a supply that is at its 
estimated end of life. The supply does not need to be replaced now unless the print quality is no longer 
acceptable.

Once an HP print cartridge has reached “Very Low”, HP’s Premium Protection Warranty on that print cartridge 
has ended. HP’s Premium Protection Warranty applies only to the print cartridge for this product.

The imaging drum installed in this product is covered by the product warranty. Replacement imaging drums 
have a one year limited warranty from the date of installation. The imaging drum installation date displays on 
both the configuration page and on the supplies status page when the imaging drum reaches approximately 
30% of its estimated remaining life.

Enable or disable the At Very Low settings

You can change the default settings at any time and do not need to re-enable the settings when a new print 
cartridge is installed. The <Supply> Very Low alert message displays when a print cartridge is set to Continue 
At Very Low. Once an HP print cartridge has reached “Very Low”, HP’s Premium Protection Warranty on that 
cartridge has ended.

1. In the Windows system tray, right-click the Device Settings  icon and then click the product name.

2. Click the System Setup tab.

3. From the At Very Low drop-down list, select one of the following options:

● Select the Continue option set the product to alert you that the print cartridge is very low, but to 
continue printing.

● Select the Stop option to set the product to alert you and stop printing until you replace the print 
cartridge.

● Select the Prompt (the default) option to set the product to stop printing and prompt you to 
replace the print cartridge. You can acknowledge the prompt and continue printing.

Manage print cartridges and imaging drums

Print-cartridge and imaging drum storage

Do not remove the print cartridge or imaging drum from their packages until you are ready to use them.
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HP policy on non-HP supplies

HP Company cannot recommend the use of non-HP print cartridges and imaging drums, either new or 
remanufactured.

NOTE: Non-HP Laser Print Cartridge Use

For HP printer products, the use of a non-HP toner cartridge or imaging drum, or a refilled toner cartridge, 
does not affect either the warranty to the customer or any HP support contract with the customer. However, if 
product failure or damage is attributable to the use of a non-HP or refilled toner cartridge, HP will charge its 
standard time and materials charges to service the product for the particular failure or damage.

HP fraud hotline and Web site

Call the HP fraud hotline (1-877-219-3183, toll-free in North America) or go to www.hp.com/go/
anticounterfeit when you install an HP print cartridge and the supplies status page message says the 
cartridge is non-HP or used. HP will help determine if the cartridge is genuine and take steps to resolve the 
problem.

Your print cartridge might not be a genuine HP print cartridge if you notice the following:

● The supplies status page indicates that a non-HP supply is installed.

● You are experiencing a high number of problems with the print cartridge.

● The cartridge does not look like it usually does (for example, the packaging differs from HP packaging).

Recycle supplies

To recycle a genuine HP print cartridge or imaging drum, place the used supply in the box in which the supply 
arrived. Use the enclosed return label to send the used supply to HP for recycling. For complete information, 
see the recycling guide that is included with each new HP supply item.

Print cartridge layout

1

2

1 Print cartridge E-label

2 Plastic shield
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Imaging drum layout

1 2

1 Imaging drum E-label

2 Plastic shield
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Replacement instructions

Replace the print cartridges

When a print cartridge approaches the end of its useful life, you can continue printing with the current print 
cartridge until it no longer yields acceptable print quality.

Once an HP print cartridge has reached “very low”, HP’s Premium Protection Warranty on that supply has 
ended. All print defects or print cartridge failures incurred when an HP supply is used in continue at very low 
mode will not be considered to be defects in materials or workmanship in the supply under the HP Print 
Cartridge Warranty Statement.

NOTE: Once an HP print cartridge has reached “very low”, the corresponding cartridge light on the control 
panel turns on.

1. Press the Cartridge  button of the print 
cartridge that requires replacement to rotate the 
print cartridge carousel for removal.

NOTE: All doors must be closed when pressing 
the Cartridge  button.

NOTE: Wait until the Cartridge  light is not 
flashing and the rotation sounds stops before 
opening the print cartridge door.

 

2. Open the print cartridge door.  

84 Chapter 8   Manage and maintain the product ENWW



3. Grasp the old print cartridge by the center handle 
and remove.

 

4. Remove the new print cartridge from the 
packaging. Place the used print cartridge in the 
bag and box for recycling.

CAUTION: To prevent damage to the print 
cartridge, hold the print cartridge at each end. Do 
not touch the roller on the print cartridge.

 

5. Grasp both sides of the print cartridge and gently 
rock the print cartridge to distribute the toner 
evenly inside the print cartridge.

 

6. Remove the tape from the print cartridge. Place 
the tape in the print-cartridge box to return for 
recycling.
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7. Remove the protective shielding from the new 
print cartridge.

 

8. Grasp the print cartridge by the center handle and 
insert into the product.

NOTE: Compare the color label on the print 
cartridge to the color label in the carousel slot to 
make sure the print cartridge color matches the 
carousel position. 

CAUTION: If toner gets on your clothing, wipe it 
off with a dry cloth and wash the clothing in cold 
water. Hot water sets toner into the fabric.
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9. Close the print cartridge door.

NOTE: After closing the print cartridge door, the 
Ready  light and Attention  light will flash. 
Allow up to three minutes for the product to 
calibrate.

NOTE: If replacing another print cartridge, you 
must close the print cartridge door before 
pressing the Cartridge  button of the next print 
cartridge.

You do not need to wait for the product to 
calibrate when replacing the second print 
cartridge. Instead, press the Cartridge  button 
for the next color to rotate the carousel into 
position. After you have replaced the print 
cartridges, the product calibrates.

NOTE: After every other black cartridge change, 
a cleaning page prints automatically to clean the 
fuser. This cleaning page process takes two 
minutes to complete.

 

10. When printing, if you receive the status alert 
message Wrong Cartridge in <Color> Slot, 
remove the print cartridge from the specified slot 
and compare the color label on the print cartridge 
to the color label in the slot to determine the 
correct print cartridge for the slot.
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Replace the imaging drum

NOTE: The imaging drum installed in this product is covered by the product warranty. Replacement imaging 
drums have a one-year limited warranty from the date of installation. The imaging drum installation date 
displays on both the configuration page and on the supplies status page when the imaging drum reaches 
approximately 30% of its estimated remaining life. HP's Premium Protection Warranty applies only to the 
print cartridges for the product.

1. Open the print cartridge door.  

2. Open the front cover.  
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3. Lift the two levers that hold the imaging drum.  

4. Remove the old imaging drum.  

5. Remove the new imaging drum from the 
packaging. Place the used imaging drum in the 
bag and box for recycling.
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6. Remove the protective shielding from the new 
imaging drum.

CAUTION: To prevent damage, do not expose 
the imaging drum to light. Cover it with a piece of 
paper.

CAUTION: Do not touch the green roller. 
Fingerprints on the imaging drum can cause 
print-quality problems.

 

7. Insert the new imaging drum in the product.  

8. Lower the two levers that hold the imaging drum.  
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9. Close the front cover.  

10. Close the print cartridge door.

NOTE: After closing the print cartridge door, the 
Ready  light and Attention  light will flash. 
Allow up to three minutes for the product to 
calibrate. 
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Clean the product

Clean the paper path

If you are experiencing toner specks or dots on the printouts, clean the paper path. This process uses a 
transparency to remove dust and toner from the paper path. Do not use bond or rough paper.

NOTE: For best results use a sheet of LaserJet transparency. If you do not have any transparencies, you can 
use copier-grade media (60 to 163 g/m2 (16 to 43 lb)) that has a smooth surface.

1. Make sure that the product is idle and the Ready  light is on.

2. Load paper in the input tray.

3. In the Windows system tray, right-click the Device Settings  icon and then click the product name.

4. Click the Device Settings tab.

5. Click the Print Cleaning Page button.

NOTE: The cleaning process takes about 2 minutes. The cleaning page stops periodically during the cleaning 
process. Do not turn the product off until the cleaning process has finished. You might need to repeat the 
cleaning process several times to thoroughly clean the product.

Clean the exterior

Use a soft, damp, lint-free cloth to wipe dust, smudges, and stains off of the exterior of the device.

Product updates
Software and firmware updates and installation instructions for this product are available at www.hp.com/
support/ljcp1020series. Click Support & Drivers, click the operating system, and then select the download 
for the product.
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9 Solve problems

● Self help

● Solve problems checklist

● Factors that affect product performance

● Restore factory settings

● Interpret control panel light patterns

● Status alert messages

● Paper feeds incorrectly or becomes jammed

● Improve print quality

● The product does not print or it prints slowly

● Solve connectivity problems 

● Solve wireless network problems

● Solve product software problems

● Solve common Mac problems
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Self help
In addition to the information in this guide, other sources are available that provide helpful information.

HP Help and Learn Center The HP Help and Learn Center and other documentation are on the CD that came with the 
product or in the HP Program folder on your computer. The HP Help and Learn Center is a 
product help tool that provides easy access to product information, HP product Web 
support, troubleshooting, and regulatory and safety information.

Quick Reference Topics Several Quick Reference Topics for this product are available at this Web site: 
www.hp.com/support/ljcp1020series

You can print these topics and keep them near the product. They are a handy reference 
for procedures that you perform frequently.
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Solve problems checklist
Follow these steps when trying to solve a problem with the product.

● Step 1: Make sure that the product is set up correctly

● Step 2: Check the cabling or wireless connection (network models only)

● Step 3: Check to see if any control-panel lights are lit

● Step 4: Check the paper

● Step 5: Check the software

● Step 6: Test print functionality

● Step 7: Check the supplies

● Step 8: Try sending a print job from a computer

Step 1: Make sure that the product is set up correctly

Make sure that the product is set up correctly.

1. Press the power button to turn on the product or to deactivate the Auto-On\Auto-Off mode.

2. Check the power-cable connections.

3. Make sure that the line voltage is correct for the product power configuration. (See the label that is on 
the back of the product for voltage requirements.) If you are using a power strip and its voltage is not 
within specifications, plug the product directly into the wall. If it is already plugged into the wall, try a 
different outlet.

4. Make sure that the print cartridge is installed correctly.

5. If none of these measures restores power, contact HP Customer Care.

Step 2: Check the cabling or wireless connection (network models only)

1. Check the cable connection between the product and the computer. Make sure that the connection is 
secure.

2. Make sure that the cable itself is not faulty by using a different cable, if possible.

Step 3: Check to see if any control-panel lights are lit

The control panel should indicate ready status. If an error message appears, resolve the error.

Step 4: Check the paper

1. Make sure that the paper that you are using meets specifications.

2. Make sure that the paper is loaded correctly in the input tray.
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Step 5: Check the software

1. Make sure that the product software is installed correctly.

2. Verify that you have installed the printer driver for this product. Check the program to make sure that 
you are using the printer driver for this product.

Step 6: Test print functionality

1. Print a configuration page. Select Print configuration page on the Services tab in the Printer 
Preferences.

2. If the page does not print, verify that the input tray contains paper.

3. If the page jams in the product, clear the jam.

Step 7: Check the supplies

Print a supplies status page and check the estimated remaining life of the print cartridges and imaging drum.

Step 8: Try sending a print job from a computer

1. Try printing the job from another computer that has the product software installed.

2. Check the USB cable connection. Direct the product to the correct port, or reinstall the software, 
selecting the connection type that you are using.

3. If the print quality is unacceptable, complete the following steps:

● Verify that the print settings are correct for the media that you are using.
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Factors that affect product performance
Several factors affect the time it takes to print a job:

● The use of special paper (such as transparencies, heavy paper, and custom-size paper)

● Product processing and download time

● The complexity and size of graphics

● The speed of the computer you are using

● The USB or network connection

● The product I/O configuration
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Restore factory settings
Restoring the factory-set defaults returns most of the settings to the factory defaults. It will not reset the 
page count, tray size, or language. To restore the product to the factory-default settings, follow these steps.

1. Turn the product off. Disconnect the power cable from the product for 30 seconds and then reconnect.

2. Turn the product on while you press and hold the Resume  button for 10-20 seconds. The Attention 
light turns on.

3. Release the Resume  button. The Attention  and Ready  lights cycle while the product restores 
factory defaults.
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Interpret control panel light patterns
Table 9-1  Status light legend

Symbol for "light off"

Symbol for "light on"

Symbol for "light blinking"

Table 9-2  Control-panel light patterns

Light status State of the product Action

All lights are off. The product is turned off. Press the power button to turn on the 
product.

The Auto-On/Auto-Off feature has turned 
off the product.

No action is required.

The attention and ready lights are 
cycling.

The lights cycle during the formatter 
initialization period or when the product is 
processing a cleaning page.

No action is required. Wait for the 
initialization period to end. The product 
should enter the ready state when the 
initialization period is finished.

Ready light is on. The product is in the ready state. No action is required. The product is ready 
to receive a print job.

Ready light blinks. The product is receiving or processing data. No action is required. The product is 
receiving or processing a print job.
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Table 9-2  Control-panel light patterns (continued)

Light status State of the product Action

Attention light blinks. Ready light is on. The product is in manual-feed mode. Load the correct paper type and size into 
the input tray.

The product is waiting to print the second 
side of a manual duplex print job.

Load the input tray with the paper from the 
output bin.

Attention light blinks. The input tray is empty. Load the tray.

Paper is jammed in the product. Clear the jam.

Attention and ready lights are on. The product has experienced a fatal error 
from which it cannot recover.

1. Turn off the product and disconnect 
the power cable from the product.

2. Wait 30 seconds and then reconnect 
the power cord and turn on the 
product.

3. Wait for the product to initialize.

If the error persists, contact HP customer 
support.

Attention and ready lights blink. Paper is jammed in the product. Clear the jam.

Cartridge light blinks. The print cartridge has rotated and is now 
accessible.

Access the print cartridge.

The print cartridge is missing or is not 
installed correctly.

Install the print cartridge.
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Table 9-2  Control-panel light patterns (continued)

Light status State of the product Action

Cartridge and attention lights blink. The print cartridge is very low and has 
reached the end of its estimated useful life. 
When the supply has reached this condition, 
the HP Premium Protection warranty for 
that supply has ended.

You do not need to replace the print 
cartridge at this time unless print quality is 
no longer acceptable. Press the Resume 
button to continue.

A non-HP print cartridge in use. You do not need to replace the print 
cartridge at this time unless print quality is 
no longer acceptable. Press the Resume 
button to continue.

Print cartridge is rotating. No action is required. Wait for the rotation 
period to end. The product should enter the 
previous state when the rotation period is 
finished.

Cartridge and ready lights are on. The print cartridge has reached the end of 
its estimated useful life. When the supply 
has reached this condition, the HP Premium 
Protection warranty for that supply has 
ended.

You do not need to replace the print 
cartridge at this time unless print quality is 
no longer acceptable.

Non-HP print cartridge in use and is very 
low.

No action is required.

Table 9-3  Wireless light patterns

Light status State of the product Action

Wireless light is off. The wireless connection is turned off. Press and hold the Wireless  button for 2 
seconds to turn on the WPS.

The Ethernet is connected. No action is required.

Wireless light blinks. The product is trying to establish a wireless 
connection.

No action is required.

There is a WPS error. Attempt to connect again.

Wireless light is on. The product has established a wireless 
connection.

No action is required.  
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Status alert messages
Status alert messages appear on the computer screen when the product has certain problems. Use the 
information in the following table to solve these problems.

Alert message Description Recommended action

Black Cartridge Low The print cartridge is nearing the estimated end 
of its useful life.

The product indicates when a print cartridge 
level is low. Actual cartridge life remaining may 
vary. Consider having a replacement available 
to install when print quality is no longer 
acceptable. The print cartridge does not need to 
be replaced now.

This alert displays only if the product is 
customer configured to stop when the print 
cartridge reaches the “very low” threshold.

Black Cartridge Very Low The print cartridge is at the estimated end of its 
useful life.

Print quality may decrease. Choose a reminder 
option or replace print cartridge when quality 
becomes unacceptable.

To ensure optimal print quality, HP 
recommends replacing the print cartridge at 
this point. You do not need to replace the print 
cartridge at this time unless print quality is no 
longer acceptable. Actual print cartridge life 
may vary.

Once an HP print cartridge has reached “very 
low”, HP's Premium Protection Warranty on 
that print cartridge has ended. All print defects 
or cartridge failures incurred when an HP 
supply is used in continue at very low mode will 
not be considered to be defects in materials or 
workmanship in the supply under the HP Print 
Cartridge Warranty Statement.

Calibrating The product is performing the internal 
calibration process to ensure the best possible 
print quality.

Wait for the process to complete.

Cartridge Memory Error on <Color> The e-label for one of the print cartridges 
cannot be read or is missing.

● Reinstall the print cartridge.

● Turn off the product and disconnect the 
power cable from the product. Wait 
30 seconds and then reconnect the power 
cord and turn on the product.

● If the problem is not solved, replace the 
cartridge.

Cool Down Mode After prolonged, continuous operation, or after 
printing on narrow paper, the product must 
pause to cool.

Printing will continue when the product has 
cooled.

Cyan Cartridge Low The print cartridge is nearing the estimated end 
of its useful life.

The product indicates when a print cartridge 
level is low. Actual cartridge life remaining may 
vary. Consider having a replacement available 
to install when print quality is no longer 
acceptable. The print cartridge does not need to 
be replaced now.

This alert displays only if the product is 
customer configured to stop when the print 
cartridge reaches the “very low” threshold.
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Alert message Description Recommended action

Cyan Cartridge Very Low The print cartridge is at the estimated end of its 
useful life.

Print quality may decrease. Choose a reminder 
option or replace print cartridge when quality 
becomes unacceptable.

To ensure optimal print quality, HP 
recommends replacing the print cartridge at 
this point. You do not need to replace the print 
cartridge at this time unless print quality is no 
longer acceptable. Actual print cartridge life 
may vary.

Once an HP print cartridge has reached “very 
low”, HP's Premium Protection Warranty on 
that print cartridge has ended. All print defects 
or cartridge failures incurred when an HP 
supply is used in continue at very low mode will 
not be considered to be defects in materials or 
workmanship in the supply under the HP Print 
Cartridge Warranty Statement.

DC Controller Error The product has experienced an internal error. Turn off the product and disconnect the power 
cable from the product. Wait 30 seconds and 
then reconnect the power cord and turn on the 
product. Wait for the product to initialize.

If you are using a surge protector, remove it. 
Plug the product directly into the wall socket. 
Use the power switch to turn on the product.

If the message persists, contact HP support.

Engine Communication Error The product experienced an internal 
communication error.

Turn off the product and disconnect the power 
cable from the product. Wait 30 seconds and 
then reconnect the power cord and turn on the 
product. Wait for the product to initialize.

If you are using a surge protector, remove it. 
Plug the product directly into the wall socket. 
Use the power switch to turn on the product.

If the message persists, contact HP support.

Front Access Door Open The door is open. Close the door.

Fuser Error The product has experienced an error with the 
fuser.

Turn off the product and disconnect the power 
cable from the product. Wait 30 seconds and 
then reconnect the power cord and turn on the 
product. Wait for the product to initialize.

If the error continues, turn off the product, 
disconnect the power cable, wait at least 
25 minutes, and then reconnect the power 
cable and turn on the product.

If you are using a surge protector, remove it. 
Plug the product directly into the wall socket. 
Use the power switch to turn on the product.

If the message persists, contact HP support.
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Alert message Description Recommended action

Imaging Drum Very Low The imaging drum is at the end of its useful life. To ensure optimal print quality, HP 
recommends replacing the imaging drum at this 
point. You do not need to replace the imaging 
drum at this time unless print quality is no 
longer acceptable. Actual imaging drum life 
may vary.

The imaging drum installed in this product is 
covered by the product warranty. Replacement 
imaging drums have a one-year limited 
warranty from the date of installation. HP's 
Premium Protection Warranty applies only to 
the print cartridge for this product. The imaging 
drum installation date displays on both the 
configuration page and on the supplies status 
page when the imaging drum reaches 
approximately 30% of its estimated remaining 
life.

Install <Color> Cartridge The cartridge is either not installed or not 
correctly installed in the product.

Install the print cartridge.

Jam in <location>

(<location> indicates the area where the jam 
has occurred)

The product has detected a jam. Clear the jam from the area indicated in the 
message. The job should continue to print. If it 
does not, try reprinting the job.

If the message persists, contact HP support.

Load Paper <Type> The tray is empty. Load print media into the tray.

Magenta Cartridge Low The print cartridge is nearing the estimated end 
of its useful life.

The product indicates when a print cartridge 
level is low. Actual cartridge life remaining may 
vary. Consider having a replacement available 
to install when print quality is no longer 
acceptable. The print cartridge does not need to 
be replaced now.

This alert displays only if the product is 
customer configured to stop when the print 
cartridge reaches the “very low” threshold.

Magenta Cartridge Very Low The print cartridge is at the estimated end of its 
useful life.

Print quality may decrease. Choose a reminder 
option or replace print cartridge when quality 
becomes unacceptable.

To ensure optimal print quality, HP 
recommends replacing the print cartridge at 
this point. You do not need to replace the print 
cartridge at this time unless print quality is no 
longer acceptable. Actual print cartridge life 
may vary.

Once an HP print cartridge has reached “very 
low”, HP's Premium Protection Warranty on 
that print cartridge has ended. All print defects 
or cartridge failures incurred when an HP 
supply is used in continue at very low mode will 
not be considered to be defects in materials or 
workmanship in the supply under the HP Print 
Cartridge Warranty Statement.

Manual feed The product is set for manual feed mode. Load the correct media into the tray, and then 
press the Resume  button to print the job.
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Alert message Description Recommended action

Non-HP <Color> Cartridge A non-HP supply has been installed. This 
message appears until an HP supply is installed 
or you press the Resume  button.

If you believe you purchased an HP supply, go 
to www.hp.com/go/anticounterfeit. Any product 
repair required as a result of using used 
supplies is not covered under warranty. Supply 
status and features depending on supply status 
will not be available

Service or repairs that are required as a result 
of using non-HP supplies are not covered under 
HP warranty.

To continue printing, press the Resume 
button.

Not Connected The product software cannot communicate with 
the product.

1. Make sure the product is turned on.

2. Make sure the USB cable is connected 
securely to the product and the computer.

Page Too Complex The product cannot process the page. Press the Resume  button to continue 
printing the job, but output might be affected.

Printer Mispick The print engine has failed to pick up a piece of 
media.

Reload the media in the input tray and press the 
Resume  button to continue the job.

If the message persists, contact HP support.

Printing The product is printing a document. Wait for printing to finish.

Rear Access Door Open The door is open. Close the door.

Replace <Color> cartridge The product has been customer configured to 
stop when the supply level is very low.

The product indicates when a supply level is 
very low. Actual cartridge life remaining may 
vary. Consider having a replacement available 
to install when print quality is no longer 
acceptable. The supply does not need to be 
replaced now unless the print quality is no 
longer acceptable. Once an HP supply has 
reached “Very Low”, HP’s warranty on that 
supply has ended.

Scanner Error An internal error has occurred. Turn off the product and disconnect the power 
cable from the product. Wait 30 seconds and 
then reconnect the power cord and turn on the 
product. Wait for the product to initialize.

If you are using a surge protector, remove it. 
Plug the product directly into the wall socket. 
Use the power switch to turn on the product.

If the message persists, contact HP support.

Supplies Very Low More than one print cartridge is at the end of its 
useful life.

The corresponding cartridge lights on the 
control panel remain on.

The product indicates when a supply level is 
very low. Actual cartridge life remaining may 
vary. Consider having a replacement available 
to install when print quality is no longer 
acceptable. The supply does not need to be 
replaced now unless the print quality is no 
longer acceptable. Once an HP supply has 
reached “Very Low”, HP’s warranty on that 
supply has ended.

Tray 1 Jam The product has detected a jam in the tray. Clear the jam.

ENWW Status alert messages 105

http://www.hp.com/go/anticounterfeit


Alert message Description Recommended action

Unexpected Paper Size The paper in the tray is not the size specified by 
the print job.

Load the correct paper size in the input tray and 
then press the Resume  button to print the 
job.

Used <Color> cartridge A used supply has been installed. This message 
appears until an HP supply is installed or you 
press the Resume  button.

If you believe you purchased an HP supply, go 
to www.hp.com/go/anticounterfeit. Any product 
repair required as a result of using used 
supplies is not covered under warranty. Supply 
status and features depending on supply status 
will not be available

Service or repairs that are required as a result 
of using non-HP supplies are not covered under 
HP warranty.

To continue printing, press the Resume 
button.

Wrong Cartridge in <Color> Slot A print cartridge is installed in the incorrect slot. Be sure that each print cartridge is in the 
correct slot. Compare the color label on the 
print cartridge with the color label in the slot.

Yellow Cartridge Low The print cartridge is nearing the estimated end 
of its useful life.

The product indicates when a print cartridge 
level is low. Actual cartridge life remaining may 
vary. Consider having a replacement available 
to install when print quality is no longer 
acceptable. The print cartridge does not need to 
be replaced now.

This alert displays only if the product is 
customer configured to stop when the print 
cartridge reaches the “very low” threshold.

Yellow Cartridge Very Low The print cartridge is at the estimated end of its 
useful life.

Print quality may decrease. Choose a reminder 
option or replace print cartridge when quality 
becomes unacceptable.

To ensure optimal print quality, HP 
recommends replacing the print cartridge at 
this point. You do not need to replace the print 
cartridge at this time unless print quality is no 
longer acceptable. Actual print cartridge life 
may vary.

Once an HP print cartridge has reached “very 
low”, HP's Premium Protection Warranty on 
that print cartridge has ended. All print defects 
or cartridge failures incurred when an HP 
supply is used in continue at very low mode will 
not be considered to be defects in materials or 
workmanship in the supply under the HP Print 
Cartridge Warranty Statement.
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Paper feeds incorrectly or becomes jammed

The product does not pick up paper

If the product does not pick up paper from the tray, try these solutions.

1. Open the product and remove any jammed sheets of paper.

2. Load the tray with the correct size of paper for your job.

NOTE: Always load paper so the short edge (width) enters the product first.

3. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides so 
they are touching the paper stack without bending it.

4. Check the product control panel to see if the product is waiting for you to acknowledge a prompt to feed 
the paper manually. Load paper, and continue.

The product picks up multiple sheets of paper

If the product picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not fan the 
paper. Return the stack of paper to the tray.

2. Use only paper that meets HP specifications for this product.

3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten the 
stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides so 
they are touching the paper stack without bending it.

Prevent paper jams

To reduce the number of paper jams, try these solutions.

1. Use only paper that meets HP specifications for this product.

2. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.

3. Use paper that has not previously been printed or copied on.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten the 
stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides so 
they are touching the paper stack without bending it.

NOTE: Always load paper so the short edge (width) enters the product first.

6. If you are printing on heavy, embossed, or perforated paper, use the manual feed feature and feed 
sheets one at a time.

Clear jams
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Jam locations

Jams can occur in these locations:

1

3

2

1 Output bin

2 Rear door

3 Input tray

Loose toner might remain in the product after a jam. This problem typically resolves itself after a few sheets 
have been printed.

Clear jams from the output bin

CAUTION: Do not use sharp objects, such as tweezers or needle-nose pliers, to remove jams. Damage 
caused by sharp objects will not be covered by the warranty.
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1. With both hands, grasp the paper, and carefully 
pull it free from the product.

 

2. Open and close the print cartridge door to reset 
the product.

 

Clear jams from the rear door

1. Open the rear door.  
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2. With both hands, grasp the paper, and carefully 
pull it free from the product.

 

3. Close the rear door.  

Clear jams from the input tray

1. Remove the paper from the input tray.  
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2. With both hands, grasp the paper, and carefully 
pull it free from the product.

 

3. Open and close the print cartridge door to reset 
the product.
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Improve print quality
You can prevent most print-quality problems by following these guidelines.

● Use the correct paper type setting in the printer driver

● Adjust color settings in the printer driver

● Use paper that meets HP specifications

● Print a cleaning page

● Calibrate the product to align colors

● Check the print cartridges

Use the correct paper type setting in the printer driver

Check the paper type setting if you are having any of the following problems:

● Toner is smearing on the printed pages.

● Repeated marks occur on the printed pages.

● Printed pages are curled.

● Toner flakes off the printed pages.

● Printed pages have small unprinted areas.

Change the paper type setting for Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Type is drop-down list, select the type of paper you are using, and click the OK button.

Change the paper type setting for Mac

1. On the File menu in the software program, click the Print option.

2. In the Copies & Pages menu, click the Page Setup button.

3. Select a size from the Paper Size drop-down list, and then click the OK button.

4. Open the Finishing menu.

5. Select a type from the Media-type drop-down list.

6. Click the Print button.
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Adjust color settings in the printer driver

Change the color theme for a print job

1. On the File menu in the software program, click Print.

2. Click Properties or Preferences.

3. Click the Color tab.

4. Select a color theme from the Color Themes drop-down list.

● Default (sRGB): This theme sets the product to print RGB data in raw device mode. When using this 
theme, manage color in the software program or in the operating system for correct rendering.

● Vivid: The product increases the color saturation in the midtones. Use this theme when printing 
business graphics.

● Photo: The product interprets RGB color as if it were printed as a photograph using a digital mini 
lab. The product renders deeper, more saturated colors differently than with the Default (sRBG) 
theme. Use this theme when printing photos.

● Photo (Adobe RGB 1998): Use this theme with printing digital photos that use the AdobeRGB color 
space rather than sRGB. Turn off color management in the software program when using this 
theme.

● None

Change the color options

Change the color options settings for the current print job from the color tab of the printer driver.

1. On the File menu in the software program, click Print.

2. Click Properties or Preferences.

3. Click the Color tab.

4. Click the Automatic or Manual setting.
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● Automatic setting: Select this setting for most color print jobs

● Manual setting: Select this setting to adjust the color settings independent from other settings.

NOTE: Changing color settings manually can impact output. HP recommends that only color 
graphics experts change these settings.

5. Click the Print in Grayscale option to print a color document in black and white. Use this option to print 
color documents for photocopying or faxing.

6. Click the OK button.

Use paper that meets HP specifications

Use different paper if you are having any of the following problems:

● The printing is too light or seems faded in areas.

● Specks of toner are on the printed pages.

● Toner is smearing on the printed pages.

● Printed characters seem misformed.

● Printed pages are curled.

Always use a paper type and weight that this product supports. In addition, follow these guidelines when 
selecting paper:

● Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust, wrinkles, 
voids, staples, and curled or bent edges.

● Use paper that has not been previously printed on.

● Use paper that is designed for use in laser printers. Do not use paper that is designed only for use in 
Inkjet printers.

● Use paper that is not too rough. Using smoother paper generally results in better print quality.
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Print a cleaning page

Print a cleaning page to remove dust and excess toner from the paper path if you are having any of the 
following problems:

● Specks of toner are on the printed pages.

● Toner is smearing on the printed pages.

● Repeated marks occur on the printed pages.

Use the following procedure to print a cleaning page.

1. Make sure that the product is idle and the Ready  light is on.

2. Load paper in the input tray.

3. In the Windows system tray, right-click the Device Settings  icon and then click the product name.

4. Click the Device Settings button.

5. Click the Print Cleaning Page button.

NOTE: The cleaning process takes about 2 minutes. The cleaning page stops periodically during the cleaning 
process. Do not turn the product off until the cleaning process has finished. You might need to repeat the 
cleaning process several times to thoroughly clean the product.

Calibrate the product to align colors

If you experience any print-quality problems, calibrate the product.

1. Make sure that the product is idle and the Ready  light is on.

2. Load paper in the input tray.

3. In the Windows system tray, right-click the Device Settings  icon and then click the product name.

4. Click the Device Settings button.

5. Click the Calibrate Now button.

Check the print cartridges

Check each print cartridge, and replace it if necessary, if you are having any of the following problems:

● The printing is too light or seems faded in areas.

● Printed pages have small unprinted areas.

● Printed pages have streaks or bands.

If you determine that you need to replace a print cartridge, print the Supplies Status Page to find the part 
number for the correct genuine HP print cartridge.
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Type of print cartridge Steps to resolve the problem

Refilled or remanufactured print cartridge HP cannot recommend the use of non-HP supplies, either new or remanufactured. 
Because they are not HP products, HP cannot influence their design or control their 
quality. If you are using a refilled or remanufactured print cartridge and are not satisfied 
with the print quality, replace the cartridge with a genuine HP cartridge that has the 
word “HP” on it, or has the HP logo on it.

Genuine HP print cartridge 1. The status alert message <Color> cartridge Very Low (or Replace Color Cartridge, 
if the printer has been customer configured to stop at Very Low) appears on the 
computer screen when the cartridge has reached the end of its designated life. The 
product indicates when a supply level is very low. Actual cartridge life remaining 
may vary. Consider having a replacement available to install when print quality is 
no longer acceptable. The supply does not need to be replaced now unless the print 
quality is no longer acceptable. Once an HP supply has reached “Very Low”, 
HP’s warranty on that supply has ended.

2. Visually inspect the print cartridges and imaging drum for debris and damage. See 
the instructions that follow. Replace the print cartridge or imaging drum if 
necessary.

3. If printed pages have marks that repeat several times at the same distance apart, 
print a cleaning page. If this does not solve the problem, use the repetitive defects 
ruler in this document to identify the cause of the problem.
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Print the Supplies Status page

Use the control panel to print configuration and supplies status pages that give details about the product and 
its current settings.

▲ Print a supplies status page. Select Print supplies status page on the Services tab in the Printer 
Preferences.

Page Description

Configuration page Prints a list of the product settings

Supplies Status page The supplies status page includes the following information:

● Approximate percentage of print cartridge life remaining

● Warranty for print cartridges and imaging drum

● Part numbers for HP print cartridges

● Number of pages printed

● Information about ordering new HP print cartridges and 
recycling used HP print cartridges

● The imaging drum's estimated life remaining and 
installation date display if less than 30% of its estimated life 
remains.
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Interpret the Print Quality Page

1. Make sure that the product is idle and the Ready  light is on.

2. Load paper in the input tray.

3. In the Windows system tray, right-click the Device Settings  icon and then click the product name.

4. Click the Device Settings button.

5. Click the Print PQ Troubleshooting Page button.

This page contains five bands of color, which are divided into four groups as indicated in the following 
illustration. By examining each group, you can isolate the problem to a particular print cartridge.

Section Print-cartridge

1 Yellow

2 Cyan

3 Black

4 Magenta

● If dots or streaks appear in only one of the groups, replace the print cartridge that correlates with that 
group.

● If dots appear in more than one group, print a cleaning page. If this does not solve the problem, 
determine if the dots are always the same color; for example, if magenta dots appear in all five color 
bands. If the dots are all the same color, replace that print cartridge.

● If streaks appear in multiple color bands, print a supplies status page to determine if the imaging drum 
has reached its estimated end of life. If imaging drum has not reached its estimated end of life, inspect 
the imaging drum for damage. If the imaging drum is not damaged, contact HP.

Inspect the print cartridge and imaging drum for damage

1. Remove the print cartridge from the product, and examine for damage.

2. If the print cartridge does not appear to be damaged, rock the print cartridge gently several times and 
reinstall it. Print a few pages to see if the problem is resolved.
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3. If the problem is not resolved, remove the imaging drum from the product, and examine the surface.

CAUTION: Do not touch the green roller. Fingerprints on the imaging drum can cause print-quality 
problems.

4. If you see any scratches, fingerprints, or other damage on the imaging drum, replace the imaging drum.

Repeating defects

If defects repeat at any of the following intervals on the page, a print cartridge or the imaging drum might be 
damaged.

● 22 mm (print cartridge)

● 26 mm (imaging drum)

● 29 mm (print cartridge)

● 94 mm (imaging drum)
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The product does not print or it prints slowly

The product does not print

If the product does not print at all, try the following solutions.

1. Make sure the product is turned on and that the control panel indicates it is ready.

● If the control panel does not indicate the product is ready, turn off the product and disconnect the 
power cable from the product. Wait 30 seconds and then reconnect the power cord and turn on the 
product. Wait for the product to initialize.

● If the control panel indicates the product is ready, press and hold the Resume  button for two to 
three seconds to print a configuration page. If successful, try sending the job again.

2. If the control panel indicates the product has an error, resolve the error and then try sending the job 
again.

3. Make sure the cables are all connected correctly. If the product is connected to a network, check the 
following items:

● Check the light next to the network connection on the product. If the network is active, the light is 
green.

● Make sure that you are using a network cable and not a phone cord to connect to the network.

● Make sure the network router, hub, or switch is turned on and that it is working correctly.

4. Install the HP software from the CD that came with the product. Using generic printer drivers can cause 
delays clearing jobs from the print queue.

5. If you are using a personal firewall system on the computer, it might be blocking communication with 
the product. Try temporarily disabling the firewall to see if it is the source of the problem.

6. If your computer or the product is connected to a wireless network, low signal quality or interference 
might be delaying print jobs.

The product prints slowly

If the product prints, but it seems slow, try the following solutions.

1. Make sure the computer meets the minimum specifications for this product. For a list of specifications, 
go to this Web site: www.hp.com/support/ljcp1020series.

2. When you configure the product to print on some paper types, such as heavy paper, the product prints 
more slowly so it can correctly fuse the toner to the paper. If the paper type setting is not correct for the 
type of paper you are using, change the setting to the correct paper type.

3. If your computer or the product is connected to a wireless network, low signal quality or interference 
might be delaying print jobs.

4. The product might be in cool down mode.
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Solve connectivity problems 

Solve direct-connect problems

If you have connected the product directly to a computer, check the cable.

● Verify that the cable is connected to the computer and to the product.

● Verify that the cable is not longer than 5 m (16.4 ft). Try using a shorter cable.

● Verify that the cable is working correctly by connecting it to another product. Replace the cable if 
necessary.

Solve network problems

Check the following items to verify that the product is communicating with the network. Before beginning, 
print a configuration page from the product control panel and locate the product IP address that is listed on 
this page.

● Poor physical connection

● The computer is using the incorrect IP address for the product

● The computer is unable to communicate with the product

● The product is using incorrect link and duplex settings for the network

● New software programs might be causing compatibility problems

● The computer or workstation might be set up incorrectly

● The product is disabled, or other network settings are incorrect

Poor physical connection

1. Verify that the product is attached to the correct network port using a cable of the correct length.

2. Verify that cable connections are secure.

3. Look at the network port connection on the back of the product, and verify that the amber activity light 
and the green link-status light are lit.

4. If the problem continues, try a different cable or port on the hub.

The computer is using the incorrect IP address for the product

1. Open the printer properties and click the Ports tab. Verify that the current IP address for the product is 
selected. The product IP address is listed on the product configuration page.

2. If you installed the product using the HP standard TCP/IP port, select the box labeled Always print to 
this printer, even if its IP address changes.

3. If you installed the product using a Microsoft standard TCP/IP port, use the hostname instead of the IP 
address.

4. If the IP address is correct, delete the product and then add it again.
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The computer is unable to communicate with the product

1. Test network communication by pinging the network.

a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and then type 
cmd.

b. Type ping followed by the IP address for your product.

c. If the window displays round-trip times, the network is working.

2. If the ping command failed, verify that the network hubs are on, and then verify that the network 
settings, the product, and the computer are all configured for the same network.

The product is using incorrect link and duplex settings for the network

HP recommends leaving this setting in automatic mode (the default setting). If you change these settings, 
you must also change them for your network.

New software programs might be causing compatibility problems

Verify that any new software programs are correctly installed and that they use the correct printer driver.

The computer or workstation might be set up incorrectly

1. Check the network drivers, printer drivers, and the network redirection.

2. Verify that the operating system is configured correctly.

The product is disabled, or other network settings are incorrect

1. Review the configuration page to check the status of the network protocol. Enable it if necessary.

2. Reconfigure the network settings if necessary.
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Solve wireless network problems

Wireless connectivity checklist

● Make sure the network cable is not connected.

● The product and the wireless router are turned on and have power. Also make sure the wireless radio in 
the product is turned on.

● The service set identifier (SSID) is correct. Print a configuration page to determine the SSID. If you are not 
sure the SSID is correct, run the wireless setup again.

● With secured networks, make sure the security information is correct. If the security information is 
incorrect, run the wireless setup again.

● If the wireless network is working correctly, try accessing other computers on the wireless network. If 
the network has Internet access, try connecting to the Internet over a wireless connection.

● The encryption method (AES or TKIP) is the same for the product as it is for the wireless access point (on 
networks using WPA security).

● The product is within the range of the wireless network. For most networks, the product must be within 
30 m (100 ft) of the wireless access point (wireless router).

● Obstacles do not block the wireless signal. Remove any large metal objects between the access point 
and the product. Make sure poles, walls, or support columns containing metal or concrete do not 
separate the product and wireless access point.

● The product is located away from electronic devices that might interfere with the wireless signal. Many 
devices can interfere with the wireless signal including motors, cordless phones, security system 
cameras, other wireless networks, and some Bluetooth devices.

● The printer driver is installed on the computer.

● You have selected the correct printer port.

● The computer and product connect to the same wireless network.

The product does not print after the wireless configuration completes

1. Make sure the product is turned on and in the ready state.

2. Turn off any third-party firewalls on your computer.

3. Make sure that the wireless network is working correctly.

4. Make sure that your computer is working correctly. If necessary, restart your computer.

The product does not print, and the computer has a third-party firewall installed

1. Update the firewall with the most recent update available from the manufacturer.

2. If programs request firewall access when you install the product or try to print, make sure you allow the 
programs to run.

3. Temporarily turn off the firewall, and then install the wireless product on the computer. Enable the 
firewall when you have completed the wireless installation.
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The wireless connection does not work after moving the wireless router or product

Make sure that the router or product connects to the same network that your computer connects to.

1. Print a configuration page.

2. Compare the service set identifier (SSID) on the configuration page to the SSID in the printer 
configuration for your computer.

3. If the numbers are not the same, the devices are not connecting to the same network. Reconfigure the 
wireless setup for your product.

Cannot connect more computers to the wireless product

1. Make sure that the other computers are within the wireless range and that no obstacles block the signal. 
For most networks, the wireless range is within 30 m (100 ft) of the wireless access point.

2. Make sure the product is turned on and in the ready state.

3. Turn off any third-party firewalls on your computer.

4. Make sure that the wireless network is working correctly.

5. Make sure that your computer is working correctly. If necessary, restart your computer.

The wireless product loses communication when connected to a VPN

● Typically, you cannot connect to a VPN and other networks at the same time.

The network does not appear in the wireless networks list

● Make sure the wireless router is turned on and has power.

● The network might be hidden. However, you can still connect to a hidden network.

The wireless network is not functioning

1. Make sure the network cable is not connected.

2. To verify if the network has lost communication, try connecting other devices to the network.

3. Test network communication by pinging the network.

a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and then type 
cmd.

b. Type ping followed by the service set identifier (SSID) for your network.

c. If the window displays round-trip times, the network is working.

4. Make sure that the router or product connects to the same network that your computer connects to.
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a. Print a configuration page.

b. Compare the service set identifier (SSID) on the configuration report to the SSID in the printer 
configuration for your computer.

c. If the numbers are not the same, the devices are not connecting to the same network. Reconfigure 
the wireless setup for your product.

ENWW Solve wireless network problems 125



Solve product software problems

Problem Solution

A printer driver for the product is not visible in the Printer folder ● Restart the computer to restart the spooler process. If the 
spooler has crashed, no printer drivers will appear in the 
Printers folder.

● Reinstall the product software.

NOTE: Close any applications that are running. To close an 
application that has an icon in the system tray, right-click 
the icon, and select Close or Disable.

● Try plugging the USB cable into a different USB port on the 
computer.

An error message was displayed during the software installation ● Reinstall the product software.

NOTE: Close any applications that are running. To close an 
application that has an icon in the task bar, right-click the 
icon, and select Close or Disable.

● Check the amount of free space on the drive where you are 
installing the product software. If necessary, free up as 
much space as you can, and reinstall the product software.

● If necessary, run the Disk Defragmenter, and reinstall the 
product software.

The product is in Ready mode, but nothing prints ● Print a Configuration page, and verify the product 
functionality.

● Verify that all of the cables are correctly seated and within 
specifications. This includes the USB and power cables. Try a 
new cable.

● If trying to connect through a wireless connection, make 
sure the network cable is not connected.
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Solve common Mac problems
● The printer driver is not listed in the Print & Fax list

● The product name does not appear in the product list in the Print & Fax list

● The printer driver does not automatically set up the selected product in the Print & Fax list

● A print job was not sent to the product that you wanted

● When connected with a USB cable, the product does not appear in the Print & Fax list after the driver is 
selected.

● You are using a generic printer driver when using a USB connection

The printer driver is not listed in the Print & Fax list

1. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/PPDs/
Contents/Resources. If necessary, reinstall the software.

2. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the software.

The product name does not appear in the product list in the Print & Fax list

1. Make sure that the cables are connected correctly and the product is on.

2. Print a configuration page to check the product name. Verify that the name on the configuration page 
matches the product name in the Print & Fax list.

3. Replace the USB or network cable with a high-quality cable.

The printer driver does not automatically set up the selected product in the Print & 
Fax list

1. Make sure that the cables are connected correctly and the product is on.

2. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/PPDs/
Contents/Resources. If necessary, reinstall the software.

3. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the software.

4. Replace the USB or network cable with a high-quality cable.

A print job was not sent to the product that you wanted

1. Open the print queue and restart the print job.

2. Another product with the same or similar name might have received your print job. Print a configuration 
page to check the product name. Verify that the name on the configuration page matches the product 
name in the Print & Fax list.
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When connected with a USB cable, the product does not appear in the Print & Fax 
list after the driver is selected.

Software troubleshooting

▲ Make sure that your Mac operating system is Mac OS X 10.5 or later.

Hardware troubleshooting

1. Make sure that the product is turned on.

2. Make sure that the USB cable is connected correctly.

3. Make sure that you are using the appropriate high-speed USB cable.

4. Make sure that you do not have too many USB devices drawing power from the chain. Disconnect all of 
the devices from the chain, and connect the cable directly to the USB port on the computer

5. Check to see if more than two non-powered USB hubs are connected in a row on the chain. Disconnect all 
of the devices from the chain, and then connect the cable directly to the USB port on the computer.

NOTE: The iMac keyboard is a non-powered USB hub.

You are using a generic printer driver when using a USB connection

If you connected the USB cable before you installed the software, you might be using a generic printer driver 
instead of the driver for this product.

1. Delete the generic printer driver.

2. Reinstall the software from the product CD. Do not connect the USB cable until the software installation 
program prompts you.

3. If multiple printers are installed, make sure that you have selected the correct printer in the Format For 
drop-down menu in the Print dialog box.
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A Specifications

● Physical specifications

● Power consumption, electrical specifications, and acoustic emissions

● Environmental specifications
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Physical specifications
Table A-1  Physical specifications1

Specification HP LaserJet Pro CP1020 Color Printer Series

Product weight 11.6 kg (25.6 lb)

Product height 222.8 mm (8.77 in)

Product depth 410.2 mm (16.15 in)

Product width 399.6 mm (15.73 in)

1 Values are based on preliminary data. See www.hp.com/support/ljcp1020series.

Power consumption, electrical specifications, and acoustic 
emissions

See www.hp.com/support/ljcp1020series for current information.

CAUTION: Power requirements are based on the country/region where the product is sold. Do not convert 
operating voltages. This will damage the product and void the product warranty.

Environmental specifications
Table A-2  Environmental specifications

 Operating1 Storage1

Temperature 10° to 32.5°C (50° to 91°F) 0° to 35°C (32° to 95°F)

Relative Humidity 10% to 80% 10% to 80%

1 Values are based on preliminary data. See www.hp.com/support/ljcp1020series.
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B Service and support

● HP limited warranty statement

● HP's Premium Protection Warranty: LaserJet toner cartridge limited warranty statement

● HP policy on non-HP supplies

● HP anticounterfeit Web site

● Data stored on the toner cartridge 

● End User License Agreement

● Customer self-repair warranty service

● Customer support
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HP limited warranty statement

HP PRODUCT DURATION OF LIMITED WARRANTY

HP LaserJet Professional CP1025, CP1025nw One-year product exchange

HP warrants to you, the end-user customer, that HP hardware and accessories will be free from defects in 
materials and workmanship after the date of purchase, for the period specified above. If HP receives notice of 
such defects during the warranty period, HP will, at its option, either repair or replace products which prove to 
be defective. Replacement products may be either new or equivalent in performance to new.

HP warrants to you that HP software will not fail to execute its programming instructions after the date of 
purchase, for the period specified above, due to defects in material and workmanship when properly installed 
and used. If HP receives notice of such defects during the warranty period, HP will replace software which 
does not execute its programming instructions due to such defects.

HP does not warrant that the operation of HP products will be uninterrupted or error free. If HP is unable, 
within a reasonable time, to repair or replace any product to a condition as warranted, you will be entitled to a 
refund of the purchase price upon prompt return of the product.

HP products may contain remanufactured parts equivalent to new in performance or may have been subject 
to incidental use.

Warranty does not apply to defects resulting from (a) improper or inadequate maintenance or calibration, (b) 
software, interfacing, parts or supplies not supplied by HP, (c) unauthorized modification or misuse, (d) 
operation outside of the published environmental specifications for the product, or (e) improper site 
preparation or maintenance.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTIES ARE EXCLUSIVE AND NO OTHER 
WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED AND HP SPECIFICALLY 
DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY, SATISFACTORY QUALITY, AND 
FITNESS FOR A PARTICULAR PURPOSE. Some countries/regions, states or provinces do not allow limitations on 
the duration of an implied warranty, so the above limitation or exclusion might not apply to you. This 
warranty gives you specific legal rights and you might also have other rights that vary from country/region to 
country/region, state to state, or province to province.

HP's limited warranty is valid in any country/region or locality where HP has a support presence for this 
product and where HP has marketed this product. The level of warranty service you receive may vary 
according to local standards. HP will not alter form, fit or function of the product to make it operate in a 
country/region for which it was never intended to function for legal or regulatory reasons.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS WARRANTY STATEMENT ARE YOUR SOLE AND 
EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE FOR 
LOSS OF DATA OR FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR 
OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE. Some countries/regions, states or 
provinces do not allow the exclusion or limitation of incidental or consequential damages, so the above 
limitation or exclusion may not apply to you.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLY PERMITTED, DO 
NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THE MANDATORY STATUTORY RIGHTS 
APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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UK, Ireland, and Malta

The HP Limited Warranty is a commercial guarantee voluntarily provided by HP. The name and address of the 
HP entity responsible for the performance of the HP Limited Warranty in your country/region is as follows:

UK: HP Inc UK Limited, Cain Road, Amen Corner, Bracknell, Berkshire, RG12 1HN

Ireland: Hewlett-Packard Ireland Limited, Liffey Park Technology Campus, Barnhall Road, Leixlip, Co.Kildare

Malta: Hewlett-Packard Europe B.V., Amsterdam, Meyrin Branch, Route du Nant-d'Avril 150, 1217 Meyrin, 
Switzerland

United Kingdom: The HP Limited Warranty benefits apply in addition to any legal rights to a guarantee from 
seller of nonconformity of goods with the contract of sale. These rights expire six years from delivery of 
goods for products purchased in England or Wales and five years from delivery of goods for products 
purchased in Scotland. However various factors may impact your eligibility to receive these rights. Consumer 
statutory rights are not limited or affected in any manner by HP Care Pack. For further information, please 
consult the following link: Consumer Legal Guarantee (www.hp.com/go/eu-legal) or you may visit the 
European Consumer Centers website (http://ec.europa.eu/consumers/solving_consumer_disputes/non-
judicial_redress/ecc-net/index_en.htm). Consumers have the right to choose whether to claim service under 
the HP Limited Warranty or against the seller under the legal guarantee.

Ireland: The HP Limited Warranty benefits apply in addition to any statutory rights from seller in relation to 
nonconformity of goods with the contract of sale. However various factors may impact your eligibility to 
receive these rights. Consumer statutory rights are not limited or affected in any manner by HP Care Pack. For 
further information, please consult the following link: Consumer Legal Guarantee (www.hp.com/go/eu-legal) 
or you may visit the European Consumer Centers website (http://ec.europa.eu/consumers/
solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). Consumers have the right to 
choose whether to claim service under the HP Limited Warranty or against the seller under the legal 
guarantee.

Malta: The HP Limited Warranty benefits apply in addition to any legal rights to a two-year guarantee from 
seller of nonconformity of goods with the contract of sale; however various factors may impact your eligibility 
to receive these rights. Consumer statutory rights are not limited or affected in any manner by the HP Limited 
Warranty. For further information, please consult the following link: Consumer Legal Guarantee 
(www.hp.com/go/eu-legal) or you may visit the European Consumer Centers website (http://ec.europa.eu/
consumers/solving_consumer_disputes/non-judicial_redress/ecc-net/index_en.htm). Consumers have the 
right to choose whether to claim service under the HP Limited Warranty or against the seller under two-year 
legal guarantee.

Austria, Belgium, Germany, and Luxemburg

Die beschränkte HP Herstellergarantie ist eine von HP auf freiwilliger Basis angebotene kommerzielle 
Garantie. Der Name und die Adresse der HP Gesellschaft, die in Ihrem Land für die Gewährung der 
beschränkten HP Herstellergarantie verantwortlich ist, sind wie folgt:

Deutschland: HP Deutschland GmbH, Schickardstr. 32, D-71034 Böblingen

Österreich: HP PPS Austria GmbH., Wienerbergstrasse 41, A-1120 Wien

Luxemburg: Hewlett-Packard Luxembourg S.C.A., 75, Parc d'Activités Capellen, Rue Pafebruc, L-8308 
Capellen

Belgien: HP Belgium BVBA, Hermeslaan 1A, B-1831 Diegem

Die Rechte aus der beschränkten HP Herstellergarantie gelten zusätzlich zu den gesetzlichen Ansprüchen 
wegen Sachmängeln auf eine zweijährige Gewährleistung ab dem Lieferdatum. Ob Sie Anspruch auf diese 
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Rechte haben, hängt von zahlreichen Faktoren ab. Die Rechte des Kunden sind in keiner Weise durch die 
beschränkte HP Herstellergarantie eingeschränkt bzw. betroffen. Weitere Hinweise finden Sie auf der 
folgenden Website: Gewährleistungsansprüche für Verbraucher oder Sie können die Website des 
Europäischen Verbraucherzentrums besuchen. Verbraucher haben das Recht zu wählen, ob sie eine Leistung 
von HP gemäß der beschränkten HP Herstellergarantie in Anspruch nehmen oder ob sie sich gemäß der 
gesetzlichen zweijährigen Haftung für Sachmängel (Gewährleistung) sich an den jeweiligen Verkäufer 
wenden.

Belgium, France, and Luxemburg

La garantie limitée HP est une garantie commerciale fournie volontairement par HP. Voici les coordonnées de 
l'entité HP responsable de l'exécution de la garantie limitée HP dans votre pays:

France: HP France SAS, 1 Avenue du Canada, 91947, Les Ulis

G.D. Luxembourg: Hewlett-Packard Luxembourg S.C.A., 75, Parc d'Activités Capellen, Rue Pafebruc, L-8308 
Capellen

Belgique: HP Belgium BVBA, Hermeslaan 1A, B-1831 Diegem

Les avantages de la garantie limitée HP s'appliquent en complément des droits dont vous disposez au titre de 
la garantie de non-conformité des biens avec le contrat de vente. Cependant, de nombreux facteurs peuvent 
avoir un impact sur le bénéfice de ces droits. Vos droits en tant que consommateur au titre de ces garanties ne 
sont en aucune façon limités ou affectés par la garantie limitée HP. Pour de plus amples informations, veuillez 
consulter le lien suivant : Garanties légales accordées au consommateur ou vous pouvez également consulter 
le site Web des Centres européens des consommateurs. Les consommateurs ont le droit de choisir de 
réclamer un service sous la garantie limitée HP ou auprès du vendeur au cours d'une garantie légale de deux 
ans.

Italy

La Garanzia limitata HP è una garanzia commerciale fornita volontariamente da HP. Di seguito sono indicati 
nome e indirizzo della società HP responsabile della fornitura dei servizi coperti dalla Garanzia limitata HP nel 
vostro Paese:

Italia: HP Italy S.r.l., Via G. Di Vittorio 9, 20063 Cernusco S/Naviglio

I vantaggi della Garanzia limitata HP vengono concessi ai consumatori in aggiunta ai diritti derivanti dalla 
garanzia di due anni fornita dal venditore in caso di non conformità dei beni rispetto al contratto di vendita. 
Tuttavia, diversi fattori possono avere un impatto sulla possibilita’ di beneficiare di tali diritti. I diritti spettanti 
ai consumatori in forza della garanzia legale non sono in alcun modo limitati, né modificati dalla Garanzia 
limitata HP. Per ulteriori informazioni, si prega di consultare il seguente link: Garanzia legale per i clienti, 
oppure visitare il sito Web dei Centri europei per i consumatori. I consumatori hanno il diritto di scegliere se 
richiedere un servizio usufruendo della Garanzia limitata HP oppure rivolgendosi al venditore per far valere la 
garanzia legale di due anni.

Spain

Su Garantía limitada de HP es una garantía comercial voluntariamente proporcionada por HP. El nombre y 
dirección de las entidades HP que proporcionan la Garantía limitada de HP (garantía comercial adicional del 
fabricante) en su país es:

España: Hewlett-Packard Española S.L. Calle Vicente Aleixandre, 1 Parque Empresarial Madrid - Las Rozas, 
E-28232 Madrid
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Los beneficios de la Garantía limitada de HP son adicionales a la garantía legal de 2 años a la que los 
consumidores tienen derecho a recibir del vendedor en virtud del contrato de compraventa; sin embargo, 
varios factores pueden afectar su derecho a recibir los beneficios bajo dicha garantía legal. A este respecto, la 
Garantía limitada de HP no limita o afecta en modo alguno los derechos legales del consumidor. Para más 
información, consulte el siguiente enlace: Garantía legal del consumidor o puede visitar el sitio web de los 
Centros europeos de los consumidores. Los clientes tienen derecho a elegir si reclaman un servicio 
acogiéndose a la Garantía limitada de HP o al vendedor de conformidad con la garantía legal de dos años.

Denmark

Den begrænsede HP-garanti er en garanti, der ydes frivilligt af HP. Navn og adresse på det HP-selskab, der er 
ansvarligt for HP's begrænsede garanti i dit land, er som følger:

Danmark: HP Inc Danmark ApS, Engholm Parkvej 8, 3450, Allerød

Den begrænsede HP-garanti gælder i tillæg til eventuelle juridiske rettigheder, for en toårig garanti fra 
sælgeren af varer, der ikke er i overensstemmelse med salgsaftalen, men forskellige faktorer kan dog påvirke 
din ret til at opnå disse rettigheder. Forbrugerens lovbestemte rettigheder begrænses eller påvirkes ikke på 
nogen måde af den begrænsede HP-garanti. Se nedenstående link for at få yderligere oplysninger: 
Forbrugerens juridiske garanti eller du kan besøge De Europæiske Forbrugercentres websted. Forbrugere har 
ret til at vælge, om de vil gøre krav på service i henhold til HP's begrænsede garanti eller hos sælger i henhold 
til en toårig juridisk garanti.

Norway

HPs garanti er en begrenset og kommersiell garanti som HP selv har valgt å tilby. Følgende lokale selskap 
innestår for garantien:

Norge: HP Norge AS, Rolfbuktveien 4b, 1364 Fornebu

HPs garanti kommer i tillegg til det mangelsansvar HP har i henhold til norsk forbrukerkjøpslovgivning, hvor 
reklamasjonsperioden kan være to eller fem år, avhengig av hvor lenge salgsgjenstanden var ment å vare. 
Ulike faktorer kan imidlertid ha betydning for om du kvalifiserer til å kreve avhjelp iht slikt mangelsansvar. 
Forbrukerens lovmessige rettigheter begrenses ikke av HPs garanti. Hvis du vil ha mer informasjon, kan du 
klikke på følgende kobling: Juridisk garanti for forbruker eller du kan besøke nettstedet til de europeiske 
forbrukersentrene. Forbrukere har retten til å velge å kreve service under HPs garanti eller iht selgerens 
lovpålagte mangelsansvaret.

Sweden

HP:s begränsade garanti är en kommersiell garanti som tillhandahålls frivilligt av HP. Namn och adress till det 
HP-företag som ansvarar för HP:s begränsade garanti i ditt land är som följer:

Sverige: HP PPS Sverige AB, SE-169 73 Stockholm

Fördelarna som ingår i HP:s begränsade garanti gäller utöver de lagstadgade rättigheterna till tre års garanti 
från säljaren angående varans bristande överensstämmelse gentemot köpeavtalet, men olika faktorer kan 
påverka din rätt att utnyttja dessa rättigheter. Konsumentens lagstadgade rättigheter varken begränsas eller 
påverkas på något sätt av HP:s begränsade garanti. Mer information får du om du följer denna länk: 
Lagstadgad garanti för konsumenter eller så kan du gå till European Consumer Centers webbplats. 
Konsumenter har rätt att välja om de vill ställa krav enligt HP:s begränsade garanti eller på säljaren enligt den 
lagstadgade treåriga garantin.
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Portugal

A Garantia Limitada HP é uma garantia comercial fornecida voluntariamente pela HP. O nome e a morada da 
entidade HP responsável pela prestação da Garantia Limitada HP no seu país são os seguintes:

Portugal: HPCP – Computing and Printing Portugal, Unipessoal, Lda., Edificio D. Sancho I, Quinta da Fonte, 
Porto Salvo, Lisboa, Oeiras, 2740 244

As vantagens da Garantia Limitada HP aplicam-se cumulativamente com quaisquer direitos decorrentes da 
legislação aplicável à garantia de dois anos do vendedor, relativa a defeitos do produto e constante do 
contrato de venda. Existem, contudo, vários fatores que poderão afetar a sua elegibilidade para beneficiar de 
tais direitos. Os direitos legalmente atribuídos aos consumidores não são limitados ou afetados de forma 
alguma pela Garantia Limitada HP. Para mais informações, consulte a ligação seguinte: Garantia legal do 
consumidor ou visite o Web site da Rede dos Centros Europeus do Consumidor. Os consumidores têm o direito 
de escolher se pretendem reclamar assistência ao abrigo da Garantia Limitada HP ou contra o vendedor ao 
abrigo de uma garantia jurídica de dois anos.

Greece and Cyprus

Η Περιορισμένη εγγύηση HP είναι μια εμπορική εγγύηση η οποία παρέχεται εθελοντικά από την HP. Η επωνυμία 
και η διεύθυνση του νομικού προσώπου ΗΡ που παρέχει την Περιορισμένη εγγύηση ΗΡ στη χώρα σας είναι η 
εξής:

Ελλάδα /Κύπρoς: HP Printing and Personal Systems Hellas EPE, Tzavella 1-3, 15232 Chalandri, Attiki

Ελλάδα /Κύπρoς: HP Συστήματα Εκτύπωσης και Προσωπικών Υπολογιστών Ελλάς Εταιρεία Περιορισμένης 
Ευθύνης, Tzavella 1-3, 15232 Chalandri, Attiki

Τα προνόμια της Περιορισμένης εγγύησης HP ισχύουν επιπλέον των νόμιμων δικαιωμάτων για διετή εγγύηση 
έναντι του Πωλητή για τη μη συμμόρφωση των προϊόντων με τις συνομολογημένες συμβατικά ιδιότητες, ωστόσο 
η άσκηση των δικαιωμάτων σας αυτών μπορεί να εξαρτάται από διάφορους παράγοντες. Τα νόμιμα δικαιώματα 
των καταναλωτών δεν περιορίζονται ούτε επηρεάζονται καθ’ οιονδήποτε τρόπο από την Περιορισμένη εγγύηση 
HP. Για περισσότερες πληροφορίες, συμβουλευτείτε την ακόλουθη τοποθεσία web: Νόμιμη εγγύηση 
καταναλωτή ή μπορείτε να επισκεφτείτε την τοποθεσία web των Ευρωπαϊκών Κέντρων Καταναλωτή. Οι 
καταναλωτές έχουν το δικαίωμα να επιλέξουν αν θα αξιώσουν την υπηρεσία στα πλαίσια της Περιορισμένης 
εγγύησης ΗΡ ή από τον πωλητή στα πλαίσια της νόμιμης εγγύησης δύο ετών.

Hungary

A HP korlátozott jótállás egy olyan kereskedelmi jótállás, amelyet a HP a saját elhatározásából biztosít. Az 
egyes országokban a HP mint gyártó által vállalt korlátozott jótállást biztosító HP vállalatok neve és címe:

Magyarország: HP Inc Magyarország Kft., H-1117 Budapest, Alíz utca 1.

A HP korlátozott jótállásban biztosított jogok azokon a jogokon felül illetik meg Önt, amelyek a termékeknek 
az adásvételi szerződés szerinti minőségére vonatkozó kétéves, jogszabályban foglalt eladói szavatosságból, 
továbbá ha az Ön által vásárolt termékre alkalmazandó, a jogszabályban foglalt kötelező eladói jótállásból 
erednek, azonban számos körülmény hatással lehet arra, hogy ezek a jogok Önt megilletik-e. További 
információért kérjük, keresse fel a következő webhelyet: Jogi Tájékoztató Fogyasztóknak vagy látogassa 
meg az Európai Fogyasztói Központok webhelyét. A fogyasztóknak jogában áll, hogy megválasszák, hogy a 
jótállással kapcsolatos igényüket a HP korlátozott jótállás alapján vagy a kétéves, jogszabályban foglalt 
eladói szavatosság, illetve, ha alkalmazandó, a jogszabályban foglalt kötelező eladói jótállás alapján 
érvényesítik.
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Czech Republic

Omezená záruka HP je obchodní zárukou dobrovolně poskytovanou společností HP. Názvy a adresy 
společností skupiny HP, které odpovídají za plnění omezené záruky HP ve vaší zemi, jsou následující:

Česká republika: HP Inc Czech Republic s. r. o., Za Brumlovkou 5/1559, 140 00 Praha 4

Výhody, poskytované omezenou zárukou HP, se uplatňuji jako doplňek k jakýmkoli právním nárokům na 
dvouletou záruku poskytnutou prodejcem v případě nesouladu zboží s kupní smlouvou. Váš nárok na uznání 
těchto práv však může záviset na mnohých faktorech. Omezená záruka HP žádným způsobem neomezuje ani 
neovlivňuje zákonná práva zákazníka. Další informace získáte kliknutím na následující odkaz: Zákonná záruka 
spotřebitele případně můžete navštívit webové stránky Evropského spotřebitelského centra. Spotřebitelé 
mají právo se rozhodnout, zda chtějí službu reklamovat v rámci omezené záruky HP nebo v rámci zákonem 
stanovené dvouleté záruky u prodejce.

Slovakia

Obmedzená záruka HP je obchodná záruka, ktorú spoločnosť HP poskytuje dobrovoľne. Meno a adresa 
subjektu HP, ktorý zabezpečuje plnenie vyplývajúce z Obmedzenej záruky HP vo vašej krajine:

Slovenská republika: HP Inc Slovakia, s.r.o., Galvaniho 7, 821 04 Bratislava

Výhody Obmedzenej záruky HP sa uplatnia vedľa prípadných zákazníkových zákonných nárokov voči 
predávajúcemu z vád, ktoré spočívajú v nesúlade vlastností tovaru s jeho popisom podľa predmetnej zmluvy. 
Možnosť uplatnenia takých prípadných nárokov však môže závisieť od rôznych faktorov. Služby Obmedzenej 
záruky HP žiadnym spôsobom neobmedzujú ani neovplyvňujú zákonné práva zákazníka, ktorý je 
spotrebiteľom. Ďalšie informácie nájdete na nasledujúcom prepojení: Zákonná záruka spotrebiteľa, prípadne 
môžete navštíviť webovú lokalitu európskych zákazníckych stredísk. Spotrebitelia majú právo zvoliť si, či chcú 
uplatniť servis v rámci Obmedzenej záruky HP alebo počas zákonnej dvojročnej záručnej lehoty u predajcu.

Poland

Ograniczona gwarancja HP to komercyjna gwarancja udzielona dobrowolnie przez HP. Nazwa i adres podmiotu 
HP odpowiedzialnego za realizację Ograniczonej gwarancji HP w Polsce:

Polska: HP Inc Polska sp. z o.o., Szturmowa 2a, 02-678 Warszawa, wpisana do rejestru przedsiębiorców 
prowadzonego przez Sąd Rejonowy dla m.st. Warszawy w Warszawie, XIII Wydział Gospodarczy Krajowego 
Rejestru Sądowego, pod numerem KRS 0000546115, NIP 5213690563, REGON 360916326, GIOŚ 
E0020757WZBW, kapitał zakładowy 480.000 PLN.

Świadczenia wynikające z Ograniczonej gwarancji HP stanowią dodatek do praw przysługujących nabywcy w 
związku z dwuletnią odpowiedzialnością sprzedawcy z tytułu niezgodności towaru z umową (rękojmia). 
Niemniej, na możliwość korzystania z tych praw mają wpływ różne czynniki. Ograniczona gwarancja HP w 
żaden sposób nie ogranicza praw konsumenta ani na nie nie wpływa. Więcej informacji można znaleźć pod 
następującym łączem: Gwarancja prawna konsumenta, można także odwiedzić stronę internetową 
Europejskiego Centrum Konsumenckiego. Konsumenci mają prawo wyboru co do możliwosci skorzystania 
albo z usług gwarancyjnych przysługujących w ramach Ograniczonej gwarancji HP albo z uprawnień 
wynikających z dwuletniej rękojmi w stosunku do sprzedawcy.

Bulgaria

Ограничената гаранция на HP представлява търговска гаранция, доброволно предоставяна от HP. Името и 
адресът на дружеството на HP за вашата страна, отговорно за предоставянето на гаранционната 
поддръжка в рамките на Ограничената гаранция на HP, са както следва:
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HP Inc Bulgaria EOOD (Ейч Пи Инк България ЕООД), гр. София 1766, район р-н Младост, бул. 
Околовръстен Път No 258, Бизнес Център Камбаните

Предимствата на Ограничената гаранция на HP се прилагат в допълнение към всички законови права за 
двугодишна гаранция от продавача при несъответствие на стоката с договора за продажба. Въпреки това, 
различни фактори могат да окажат влияние върху условията за получаване на тези права. Законовите 
права на потребителите не са ограничени или засегнати по никакъв начин от Ограничената гаранция на 
HP. За допълнителна информация, моля вижте Правната гаранция на потребителя или посетете уебсайта 
на Европейския потребителски център. Потребителите имат правото да избират дали да претендират за 
извършване на услуга в рамките на Ограничената гаранция на HP или да потърсят такава от търговеца в 
рамките на двугодишната правна гаранция.

Romania

Garanția limitată HP este o garanție comercială furnizată în mod voluntar de către HP. Numele și adresa 
entității HP răspunzătoare de punerea în aplicare a Garanției limitate HP în țara dumneavoastră sunt 
următoarele:

Romănia: HP Inc Romania SRL, 6 Dimitrie Pompeiu Boulevard, Building E, 2nd floor, 2nd District, Bucureşti

Beneficiile Garanției limitate HP se aplică suplimentar faţă de orice drepturi privind garanţia de doi ani oferită 
de vânzător pentru neconformitatea bunurilor cu contractul de vânzare; cu toate acestea, diverşi factori pot 
avea impact asupra eligibilităţii dvs. de a beneficia de aceste drepturi. Drepturile legale ale consumatorului nu 
sunt limitate sau afectate în vreun fel de Garanția limitată HP. Pentru informaţii suplimentare consultaţi 
următorul link: garanția acordată consumatorului prin lege sau puteți accesa site-ul Centrul European al 
Consumatorilor. Consumatorii au dreptul să aleagă dacă să pretindă despăgubiri în cadrul Garanței limitate HP 
sau de la vânzător, în cadrul garanției legale de doi ani.

Belgium and the Netherlands

De Beperkte Garantie van HP is een commerciële garantie vrijwillig verstrekt door HP. De naam en het adres 
van de HP-entiteit die verantwoordelijk is voor het uitvoeren van de Beperkte Garantie van HP in uw land is 
als volgt:

Nederland: HP Nederland B.V., Startbaan 16, 1187 XR Amstelveen

België: HP Belgium BVBA, Hermeslaan 1A, B-1831 Diegem

De voordelen van de Beperkte Garantie van HP vormen een aanvulling op de wettelijke garantie voor 
consumenten gedurende twee jaren na de levering te verlenen door de verkoper bij een gebrek aan 
conformiteit van de goederen met de relevante verkoopsovereenkomst. Niettemin kunnen diverse factoren 
een impact hebben op uw eventuele aanspraak op deze wettelijke rechten. De wettelijke rechten van de 
consument worden op geen enkele wijze beperkt of beïnvloed door de Beperkte Garantie van HP. Raadpleeg 
voor meer informatie de volgende webpagina: Wettelijke garantie van de consument of u kan de website van 
het Europees Consumenten Centrum bezoeken. Consumenten hebben het recht om te kiezen tussen enerzijds 
de Beperkte Garantie van HP of anderzijds het aanspreken van de verkoper in toepassing van de wettelijke 
garantie.

Finland

HP:n rajoitettu takuu on HP:n vapaaehtoisesti antama kaupallinen takuu. HP:n myöntämästä takuusta 
maassanne vastaavan HP:n edustajan yhteystiedot ovat:

Suomi: HP Finland Oy, Piispankalliontie, FIN - 02200 Espoo
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HP:n takuun edut ovat voimassa mahdollisten kuluttajansuojalakiin perustuvien oikeuksien lisäksi sen 
varalta, että tuote ei vastaa myyntisopimusta. Saat lisätietoja seuraavasta linkistä: Kuluttajansuoja tai voit 
käydä Euroopan kuluttajakeskuksen sivustolla. Kuluttajilla on oikeus vaatia virheen korjausta HP:n takuun ja 
kuluttajansuojan perusteella HP:lta tai myyjältä.

Slovenia

Omejena garancija HP je prostovoljna trgovska garancija, ki jo zagotavlja podjetje HP. Ime in naslov poslovne 
enote HP, ki je odgovorna za omejeno garancijo HP v vaši državi, sta naslednja:

Slovenija: Hewlett-Packard Europe B.V., Amsterdam, Meyrin Branch, Route du Nant-d'Avril 150, 1217 Meyrin, 
Switzerland

Ugodnosti omejene garancije HP veljajo poleg zakonskih pravic, ki ob sklenitvi kupoprodajne pogodbe izhajajo 
iz dveletne garancije prodajalca v primeru neskladnosti blaga, vendar lahko na izpolnjevanje pogojev za 
uveljavitev pravic vplivajo različni dejavniki. Omejena garancija HP nikakor ne omejuje strankinih z zakonom 
predpisanih pravic in ne vpliva nanje. Za dodatne informacije glejte naslednjo povezavo: Strankino pravno 
jamstvo; ali pa obiščite spletno mesto evropskih središč za potrošnike. Potrošniki imajo pravico izbrati, ali 
bodo uveljavljali pravice do storitev v skladu z omejeno garancijo HP ali proti prodajalcu v skladu z dvoletno 
zakonsko garancijo.

Croatia

HP ograničeno jamstvo komercijalno je dobrovoljno jamstvo koje pruža HP. Ime i adresa HP subjekta 
odgovornog za HP ograničeno jamstvo u vašoj državi:

Hrvatska: HP Computing and Printing d.o.o. za računalne i srodne aktivnosti, Radnička cesta 41, 10000 
Zagreb

Pogodnosti HP ograničenog jamstva vrijede zajedno uz sva zakonska prava na dvogodišnje jamstvo kod bilo 
kojeg prodavača s obzirom na nepodudaranje robe s ugovorom o kupnji. Međutim, razni faktori mogu utjecati 
na vašu mogućnost ostvarivanja tih prava. HP ograničeno jamstvo ni na koji način ne utječe niti ne ograničava 
zakonska prava potrošača. Dodatne informacije potražite na ovoj adresi: Zakonsko jamstvo za potrošače ili 
možete posjetiti web-mjesto Europskih potrošačkih centara. Potrošači imaju pravo odabrati žele li ostvariti 
svoja potraživanja u sklopu HP ograničenog jamstva ili pravnog jamstva prodavača u trajanju ispod dvije 
godine.

Latvia

HP ierobežotā garantija ir komercgarantija, kuru brīvprātīgi nodrošina HP. HP uzņēmums, kas sniedz HP 
ierobežotās garantijas servisa nodrošinājumu jūsu valstī:

Latvija: HP Finland Oy, PO Box 515, 02201 Espoo, Finland

HP ierobežotās garantijas priekšrocības tiek piedāvātas papildus jebkurām likumīgajām tiesībām uz 
pārdevēja un/vai rażotāju nodrošinātu divu gadu garantiju gadījumā, ja preces neatbilst pirkuma līgumam, 
tomēr šo tiesību saņemšanu var ietekmēt vairāki faktori. HP ierobežotā garantija nekādā veidā neierobežo un 
neietekmē patērētāju likumīgās tiesības. Lai iegūtu plašāku informāciju, izmantojiet šo saiti: Patērētāju 
likumīgā garantija vai arī Eiropas Patērētāju tiesību aizsardzības centra tīmekļa vietni. Patērētājiem ir tiesības 
izvēlēties, vai pieprasīt servisa nodrošinājumu saskaņā ar HP ierobežoto garantiju, vai arī pārdevēja sniegto 
divu gadu garantiju.

Lithuania

HP ribotoji garantija yra HP savanoriškai teikiama komercinė garantija. Toliau pateikiami HP bendrovių, 
teikiančių HP garantiją (gamintojo garantiją) jūsų šalyje, pavadinimai ir adresai:

ENWW HP limited warranty statement 139



Lietuva: HP Finland Oy, PO Box 515, 02201 Espoo, Finland

HP ribotoji garantija papildomai taikoma kartu su bet kokiomis kitomis įstatymais nustatytomis teisėmis į 
pardavėjo suteikiamą dviejų metų laikotarpio garantiją dėl prekių atitikties pardavimo sutarčiai, tačiau tai, ar 
jums ši teisė bus suteikiama, gali priklausyti nuo įvairių aplinkybių. HP ribotoji garantija niekaip neapriboja ir 
neįtakoja įstatymais nustatytų vartotojo teisių. Daugiau informacijos rasite paspaudę šią nuorodą: Teisinė 
vartotojo garantija arba apsilankę Europos vartotojų centro internetinėje svetainėje. Vartotojai turi teisę 
prašyti atlikti techninį aptarnavimą pagal HP ribotąją garantiją arba pardavėjo teikiamą dviejų metų 
įstatymais nustatytą garantiją.

Estonia

HP piiratud garantii on HP poolt vabatahtlikult pakutav kaubanduslik garantii. HP piiratud garantii eest 
vastutab HP üksus aadressil:

Eesti: HP Finland Oy, PO Box 515, 02201 Espoo, Finland

HP piiratud garantii rakendub lisaks seaduses ettenähtud müüjapoolsele kaheaastasele garantiile, juhul kui 
toode ei vasta müügilepingu tingimustele. Siiski võib esineda asjaolusid, mille puhul teie jaoks need õigused 
ei pruugi kehtida. HP piiratud garantii ei piira ega mõjuta mingil moel tarbija seadusjärgseid õigusi. Lisateavet 
leiate järgmiselt lingilt: tarbija õiguslik garantii või võite külastada Euroopa tarbijakeskuste veebisaiti. Tarbijal 
on õigus valida, kas ta soovib kasutada HP piiratud garantiid või seadusega ette nähtud müüjapoolset 
kaheaastast garantiid.

Russia

Срок службы принтера для России

Срок службы данного принтера HP составляет пять лет в нормальных условиях эксплуатации. Срок 
службы отсчитывается с момента ввода принтера в эксплуатацию. В конце срока службы HP рекомендует 
посетить веб-сайт нашей службы поддержки по адресу http://www.hp.com/support и/или связаться с 
авторизованным поставщиком услуг HP для получения рекомендаций в отношении дальнейшего 
безопасного использования принтера.

140 Appendix B   Service and support ENWW



HP's Premium Protection Warranty: LaserJet toner cartridge 
limited warranty statement

This HP product is warranted to be free from defects in materials and workmanship.

This warranty does not apply to products that (a) have been refilled, refurbished, remanufactured or 
tampered with in any way, (b) experience problems resulting from misuse, improper storage, or operation 
outside of the published environmental specifications for the printer product or (c) exhibit wear from ordinary 
use.

To obtain warranty service, please return the product to place of purchase (with a written description of the 
problem and print samples) or contact HP customer support. At HP's option, HP will either replace products 
that prove to be defective or refund your purchase price.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO OTHER WARRANTY OR 
CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY 
IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A 
PARTICULAR PURPOSE.

TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE FOR DIRECT, 
SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE, WHETHER 
BASED IN CONTRACT, TORT, OR OTHERWISE.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLY PERMITTED, DO 
NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THE MANDATORY STATUTORY RIGHTS 
APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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HP policy on non-HP supplies
HP cannot recommend the use of non-HP toner cartridges, either new or remanufactured.

NOTE: For HP printer products, the use of a non-HP toner cartridge or a refilled toner cartridge does not 
affect either the warranty to the customer or any HP support contract with the customer. However, if product 
failure or damage is attributable to the use of a non-HP toner cartridge or refilled toner cartridge, HP will 
charge its standard time and materials charges to service the product for the particular failure or damage.
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HP anticounterfeit Web site
Go to www.hp.com/go/anticounterfeit when you install an HP toner cartridge and the control-panel message 
indicates the cartridge is non-HP. HP will help determine if the cartridge is genuine and take steps to resolve 
the problem.

Your toner cartridge might not be a genuine HP toner cartridge if you notice the following:

● The supplies status page indicates that a non-HP supply is installed.

● You are experiencing a high number of problems with the cartridge.

● The cartridge does not look like it usually does (for example, the packaging differs from HP packaging).
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Data stored on the toner cartridge
The HP toner cartridges used with this product contain a memory chip that assists in the operation of the 
product.

In addition, this memory chip collects a limited set of information about the usage of the product, which 
might include the following: the date when the toner cartridge was first installed, the date when the toner 
cartridge was last used, the number of pages printed using the toner cartridge, the page coverage, the 
printing modes used, any printing errors that might have occurred, and the product model. This information 
helps HP design future products to meet our customers' printing needs.

The data collected from the toner cartridge memory chip does not contain information that can be used to 
identify a customer or user of the toner cartridge or their product.

HP collects a sampling of the memory chips from toner cartridges returned to HP's free return and recycling 
program (HP Planet Partners: www.hp.com/recycle). The memory chips from this sampling are read and 
studied in order to improve future HP products. HP partners who assist in recycling this toner cartridge might 
have access to this data, as well.

Any third party possessing the toner cartridge might have access to the anonymous information on the 
memory chip.
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End User License Agreement
READ CAREFULLY BEFORE USING THIS SOFTWARE EQUIPMENT: This End-User license Agreement ("EULA") is a 
legal agreement between (a) you (either an individual or a single entity) and (b) HP Inc. ("HP") that governs 
your use of any Software Product, installed on or made available by HP for use with your HP product ("HP 
Product"), that is not otherwise subject to a separate license agreement between you and HP or its suppliers. 
Other software may contain a EULA in its online documentation. The term "Software Product" means 
computer software and may include associated media, printed materials and "online" or electronic 
documentation.

An amendment or addendum to this EULA may accompany the HP Product.

RIGHTS IN THE SOFTWARE PRODUCT ARE OFFERED ONLY ON THE CONDITION THAT YOU AGREE TO ALL TERMS 
AND CONDITIONS OF THIS EULA. BY INSTALLING, COPYING, DOWNLOADING, OR OTHERWISE USING THE 
SOFTWARE PRODUCT, YOU AGREE TO BE BOUND BY THE TERMS OF THIS EULA. IF YOU DO NOT ACCEPT THESE 
LICENSE TERMS, YOUR SOLE REMEDY IS TO RETURN THE ENTIRE UNUSED PRODUCT (HARDWARE AND 
SOFTWARE) WITHIN 14 DAYS FOR A REFUND SUBJECT TO THE REFUND POLICY OF YOUR PLACE OF PURCHASE.

1. GRANT OF LICENSE. HP grants you the following rights provided you comply with all terms and 
conditions of this EULA:

a. Use. You may use the Software Product on a single computer ("Your Computer"). If the Software 
Product is provided to you via the internet and was originally licensed for use on more than one 
computer, you may install and use the Software Product only on those computers. You may not 
separate component parts of the Software Product for use on more than one computer. You do not 
have the right to distribute the Software Product. You may load the Software Product into Your 
Computer's temporary memory (RAM) for purposes of using the Software Product.

b. Storage. You may copy the Software Product into the local memory or storage device of the HP 
Product.

c. Copying. You may make archival or back-up copies of the Software Product, provided the copy 
contains all of the original Software Product's proprietary notices and that it is used only for back-
up purposes.

d. Reservation of Rights. HP and its suppliers reserve all rights not expressly granted to you in this 
EULA.

e. Freeware. Notwithstanding the terms and conditions of this EULA, all or any portion of the 
Software Product which constitutes non-proprietary HP software or software provided under 
public license by third parties ("Freeware"), is licensed to you subject to the terms and conditions of 
the software license agreement accompanying such Freeware whether in the form of a discrete 
agreement, shrink wrap license or electronic license terms accepted at time of download. Use of 
the Freeware by you shall be governed entirely by the terms and conditions of such license.

f. Recovery Solution. Any software recovery solution provided with/for your HP Product, whether in 
the form of a hard disk drive-based solution, an external media-based recovery solution (e.g. 
floppy disk, CD or DVD) or an equivalent solution delivered in any other form, may only be used for 
restoring the hard disk of the HP Product with/for which the recovery solution was originally 
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purchased. The use of any Microsoft operating system software contained in such recovery 
solution shall be governed by the Microsoft License Agreement.

2. UPGRADES. To use a Software Product identified as an upgrade, you must first be licensed for the 
original Software Product identified by HP as eligible for the upgrade. After upgrading, you may no 
longer use the original Software Product that formed the basis for your upgrade eligibility. By using the 
Software Product, you also agree that HP may automatically access your HP Product when connected to 
the internet to check the version or status of certain Software Products and may automatically 
download and install upgrades or updates to such Software Products on to your HP Product to provide 
new versions or updates required to maintain the functionality, performance, or security of the HP 
Software and your HP Product and facilitate the provision of support or other services provided to you. 
In certain cases, and depending on the type of upgrade or update, notifications will be provided to you 
(via pop-up or other means), which may require you to initiate the upgrade or update.

3. ADDITIONAL SOFTWARE. This EULA applies to updates or supplements to the original Software Product 
provided by HP unless HP provides other terms along with the update or supplement. In case of a 
conflict between such terms, the other terms will prevail.

4. TRANSFER.

a. Third Party. The initial user of the Software Product may make a one-time transfer of the Software 
Product to another end user. Any transfer must include all component parts, media, printed 
materials, this EULA, and if applicable, the Certificate of Authenticity. The transfer may not be an 
indirect transfer, such as a consignment. Prior to the transfer, the end user receiving the 
transferred product must agree to all the EULA terms. Upon transfer of the Software Product, your 
license is automatically terminated.

b. Restrictions. You may not rent, lease or lend the Software Product or use the Software Product for 
commercial timesharing or bureau use. You may not sublicense, assign or transfer the license or 
Software Product except as expressly provided in this EULA.

5. PROPRIETARY RIGHTS. All intellectual property rights in the Software Product and user documentation 
are owned by HP or its suppliers and are protected by law, including but not limited to United States 
copyright, trade secret, and trademark law, as well as other applicable laws and international treaty 
provisions. You shall not remove any product identification, copyright notices or proprietary restrictions 
from the Software Product.

6. LIMITATION ON REVERSE ENGINEERING. You may not reverse engineer, decompile, or disassemble the 
Software Product, except and only to the extent that the right to do so is mandated under applicable law 
notwithstanding this limitation or it is expressly provided for in this EULA.

7. TERM. This EULA is effective unless terminated or rejected. This EULA will also terminate upon 
conditions set forth elsewhere in this EULA or if you fail to comply with any term or condition of this 
EULA.

8. CONSENT TO COLLECTION/USE OF DATA.

a. HP will use cookies and other web technology tools to collect anonymous technical information 
related to HP Software and your HP Product. This data will be used to provide the upgrades and 
related support or other services described in Section 2. HP will also collect personal information 
including your Internet Protocol address or other unique identifier information associated with 
your HP Product and data provided by you on registration of your HP Product. As well as providing 
the upgrades and related support or other services, this data will be used for sending marketing 
communications to you (in each case with your express consent where required by applicable law).

To the extent permitted by applicable law, by accepting these terms and conditions you consent to 
the collection and use of anonymous and personal data by HP, its subsidiaries, and affiliates as 
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described in this EULA and as further described in HP’s privacy policy: www8.hp.com/us/en/
privacy/privacy.html?jumpid=reg_r1002_usen_c-001_title_r0001

b. Collection/Use by Third Parties. Certain software programs included in your HP Product are 
provided and separately licensed to you by third party providers (“Third Party Software”). Third 
Party Software may be installed and operational on your HP Product even if you choose not to 
activate/purchase such software. Third Party Software may collect and transmit technical 
information about your system (i.e., IP address, unique device identifier, software version installed, 
etc.) and other system data. This information is used by the third party to identify technical system 
attributes and ensure that the most current version of the software has been installed on your 
system. If you do not want the Third Party Software to collect this technical information or 
automatically send you version updates, you should uninstall the software prior to connecting to 
the Internet.

9. DISCLAIMER OF WARRANTIES. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, HP AND ITS 
SUPPLIERS PROVIDE THE SOFTWARE PRODUCT “AS IS” AND WITH ALL FAULTS, AND HEREBY DISCLAIM ALL 
OTHER WARRANTIES, GUARANTEES, AND CONDITIONS, EITHER EXPRESS, IMPLIED, OR STATUTORY, 
INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF TITLE AND NON-INFRINGEMENT, ANY IMPLIED 
WARRANTIES, DUTIES, GUARANTEES, OR CONDITIONS OF MERCHANTABILITY, OF SATISFACTORY QUALITY, 
OF FITNESS FOR A PARTICULAR PURPOSE, AND OF LACK OF VIRUSES ALL WITH REGARD TO THE 
SOFTWARE PRODUCT. Some states/jurisdictions do not allow exclusion of implied warranties or 
limitations on the duration of implied warranties, so the above disclaimer may not apply to you in its 
entirety.

IN AUSTRALIA AND NEW ZEALAND, THE SOFTWARE COMES WITH GUARANTEES THAT CANNOT BE 
EXCLUDED UNDER AUSTRALIAN AND NEW ZEALAND CONSUMER LAWS. AUSTRALIAN CONSUMERS ARE 
ENTITLED TO A REPLACEMENT OR A REFUND FOR A MAJOR FAILURE AND COMPENSATION FOR OTHER 
REASONABLY FORESEEABLE LOSS OR DAMAGE. AUSTRALIAN CONSUMERS ARE ALSO ENTITLED TO HAVE 
THE SOFTWARE REPAIRED OR REPLACED IF IT FAILS TO BE OF ACCEPTABLE QUALITY AND THE FAILURE 
DOES NOT AMOUNT TO A MAJOR FAILURE. NEW ZEALAND CONSUMERS WHO ARE PURCHASING GOODS 
FOR PERSONAL, DOMESTIC OR HOUSEHOLD USE OR CONSUMPTION AND NOT FOR THE PURPOSE OF A 
BUSINESS (“NEW ZEALAND CONSUMERS”) ARE ENTITLED TO REPAIR, REPLACEMENT OR REFUND FOR A 
FAILURE AND COMPENSATION FOR OTHER REASONABLY FORESEEABLE LOSS OR DAMAGE.

10. LIMITATION OF LIABILITY. Subject to local law, notwithstanding any damages that you might incur, the 
entire liability of HP and any of its suppliers under any provision of this EULA and your exclusive remedy 
for all of the foregoing shall be limited to the greater of the amount actually paid by you separately for 
the Software Product or U.S. $5.00. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO 
EVENT SHALL HP OR ITS SUPPLIERS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR 
CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR LOSS OF 
PROFITS OR CONFIDENTIAL OR OTHER INFORMATION, FOR BUSINESS INTERRUPTION, FOR PERSONAL 
INJURY, FOR LOSS OF PRIVACY ARISING OUT OF OR IN ANY WAY RELATED TO THE USE OF OR INABILITY TO 
USE THE SOFTWARE PRODUCT, OR OTHERWISE IN CONNECTION WITH ANY PROVISION OF THIS EULA, 
EVEN IF HP OR ANY SUPPLIER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND EVEN IF 
THE REMEDY FAILS OF ITS ESSENTIAL PURPOSE. Some states/jurisdictions do not allow the exclusion or 
limitation of incidental or consequential damages, so the above limitation or exclusion may not apply to 
you.

11. U.S. GOVERNMENT CUSTOMERS. Consistent with FAR 12.211 and 12.212, Commercial Computer 
Software, Computer Software Documentation, and Technical Data for Commercial Items are licensed to 
the U.S. Government under HP's standard commercial license.

12. COMPLIANCE WITH EXPORT LAWS. You shall comply with all laws and regulations of the United States 
and other countries ("Export Laws") to assure that the Software Product is not (1) exported, directly or 
indirectly, in violation of Export Laws, or (2) used for any purpose prohibited by Export Laws, including, 
without limitation, nuclear, chemical, or biological weapons proliferation.
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13. CAPACITY AND AUTHORITY TO CONTRACT. You represent that you are of the legal age of majority in 
your state of residence and, if applicable, you are duly authorized by your employer to enter into this 
contract.

14. APPLICABLE LAW. This EULA is governed by the laws of the country in which the equipment was 
purchased.

15. ENTIRE AGREEMENT. This EULA (including any addendum or amendment to this EULA which is included 
with the HP Product) is the entire agreement between you and HP relating to the Software Product and it 
supersedes all prior or contemporaneous oral or written communications, proposals and 
representations with respect to the Software Product or any other subject matter covered by this EULA. 
To the extent the terms of any HP policies or programs for support services conflict with the terms of 
this EULA, the terms of this EULA shall control.

© Copyright 2015 HP Development Company, L.P.

The information contained herein is subject to change without notice. All other product names mentioned 
herein may be trademarks of their respective companies. To the extent permitted by applicable law, the only 
warranties for HP products and services are set forth in the express warranty statements accompanying such 
products and services. Nothing herein should be construed as constituting an additional warranty. To the 
extent permitted by applicable law, HP shall not be liable for technical or editorial errors or omissions 
contained herein.

First Edition: August 2015
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Customer self-repair warranty service
HP products are designed with many Customer Self Repair (CSR) parts to minimize repair time and allow for 
greater flexibility in performing defective parts replacement. If during the diagnosis period, HP identifies that 
the repair can be accomplished by the use of a CSR part, HP will ship that part directly to you for replacement. 
There are two categories of CSR parts: 1) Parts for which customer self repair is mandatory. If you request HP 
to replace these parts, you will be charged for the travel and labor costs of this service. 2) Parts for which 
customer self repair is optional. These parts are also designed for Customer Self Repair. If, however, you 
require that HP replace them for you, this may be done at no additional charge under the type of warranty 
service designated for your product.

Based on availability and where geography permits, CSR parts will be shipped for next business day delivery. 
Same-day or four-hour delivery may be offered at an additional charge where geography permits. If 
assistance is required, you can call the HP Technical Support Center and a technician will help you over the 
phone. HP specifies in the materials shipped with a replacement CSR part whether a defective part must be 
returned to HP. In cases where it is required to return the defective part to HP, you must ship the defective 
part back to HP within a defined period of time, normally five (5) business days. The defective part must be 
returned with the associated documentation in the provided shipping material. Failure to return the defective 
part may result in HP billing you for the replacement. With a customer self repair, HP will pay all shipping and 
part return costs and determine the courier/carrier to be used.
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Customer support

Get telephone support for your country/region

Have the product name, serial number, date of purchase, and 
problem description ready.

Country/region phone numbers are on the flyer that was in the 
box with your product or at www.hp.com/support/.

Get 24-hour Internet support, and download software utilities 
and drivers

www.hp.com/support/ljcp1020series

Order additional HP service or maintenance agreements www.hp.com/go/carepack

Register your product www.register.hp.com
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Protecting the environment
HP is committed to providing quality products in an environmentally sound manner. This product has been 
designed with several attributes to minimize impacts on our environment.

Ozone production
The airborne emissions of ozone for this product has been measured according to a generally recognized 
method* and when these emissions data are applied to a “generic office model exposure scenario”**, HP is 
able to determine there is no appreciable amount of ozone generated during printing that exceeds any 
current indoor air quality standards or guidelines.

* Test method for the determination of emissions from hardcopy devices with respect to awarding the 
environmental label for office devices with printing function; RAL-UZ 171 – BAM July, 2012

** Based on ozone concentration when printing 2 hours per day in a 32 cubic meter room with a ventilation 
rate of 0.72 air changes per hour with HP printing supplies

Power consumption
Power usage drops significantly while in Ready, Sleep, or Off mode, which saves natural resources and saves 
money without affecting the high performance of this product. HP printing and imaging equipment marked 
with the ENERGY STAR® logo is qualified to the U.S. Environmental Protection Agency's ENERGY STAR 
specifications for imaging equipment. The following mark will appear on ENERGY STAR qualified imaging 
products:

Additional ENERGY STAR qualified imaging product model information is listed at:

www.hp.com/go/energystar

Toner consumption
EconoMode uses less toner, which might extend the life of the print cartridge. HP does not recommend the 
full-time use of EconoMode. If EconoMode is used full-time, the toner supply might outlast the mechanical 
parts in the print cartridge. If print quality begins to degrade and is no longer acceptable, consider replacing 
the print cartridge.
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Paper use
This product’s duplex feature (manual or automatic) and N-up printing (multiple pages printed on one page) 
capability can reduce paper usage and the resulting demands on natural resources.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability to 
identify plastics for recycling purposes at the end of the product’s life.

HP LaserJet print supplies
Original HP Supplies were designed with the environment in mind. HP makes it easy to conserve resources 
and paper when printing. And when you are done, we make it easy and free to recycle.1

All HP cartridges returned to HP Planet Partners go through a multiphase recycling process where materials 
are separated and refined for use as raw material in new Original HP cartridges and everyday products. No 
Original HP cartridges returned through HP Planet Partners are ever sent to a landfill, and HP never refills or 
resells Original HP cartridges.

To participate in HP Planet Partners return and recycling program, visit www.hp.com/recycle. Select your 
country/region for information on how to return HP printing supplies. Multi-lingual program information 
and instructions are also included in every new HP LaserJet print cartridge package.

1 Program availability varies. For more information, visit www.hp.com/recycle.

Paper
This product is capable of using recycled paper and lightweight paper (EcoFFICIENT™) when the paper meets 
the guidelines outlined in the HP LaserJet Printer Family Print Media Guide. This product is suitable for the use 
of recycled paper and lightweight paper (EcoFFICIENT™) according to EN12281:2002.

Material restrictions
This HP product does not contain added mercury.

This HP product does not contain a battery.

Disposal of waste equipment by users (EU and India)
This symbol means do not dispose of your product with your other household waste. Instead, you should 
protect human health and the environment by handing over your waste equipment to a designated collection 
point for the recycling of waste electrical and electronic equipment. For more information, please contact your 
household waste disposal service, or go to: www.hp.com/recycle.
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Electronic hardware recycling
HP encourages customers to recycle used electronic hardware. For more information about recycling 
programs go to: www.hp.com/recycle.

Brazil hardware recycling information
Este produto eletrônico e seus componentes não devem ser descartados no lixo comum, pois embora estejam 
em conformidade com padrões mundiais de restrição a substâncias nocivas, podem conter, ainda que em 
quantidades mínimas, substâncias impactantes ao meio ambiente. Ao final da vida útil deste produto, o 
usuário deverá entregá-lo à HP. A não observância dessa orientação sujeitará o infrator às sanções previstas 
em lei.

Após o uso, as pilhas e/ou baterias dos produtos HP deverão ser entregues ao estabelecimento comercial ou 
rede de assistência técnica autorizada pela HP.

Para maiores informações, inclusive sobre os pontos de recebimento, acesse:

www.hp.com.br/reciclar

Chemical substances
HP is committed to providing our customers with information about the chemical substances in our products 
as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006 of the European 
Parliament and the Council). A chemical information report for this product can be found at: www.hp.com/go/
reach.

Product Power Data per European Union Commission Regulation 
1275/2008

For product power data, including the power consumption of the product in networked standby if all wired 
network ports are connected and all wireless network ports are activated, please refer to section P14 
‘Additional Information’ of the product IT ECO Declaration at www.hp.com/hpinfo/globalcitizenship/
environment/productdata/itecodesktop-pc.html.

Restriction on Hazardous Substances statement (India)

Restriction on Hazardous Substances statement (Turkey)
Türkiye Cumhuriyeti: EEE Yönetmeliğine Uygundur
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Restriction on Hazardous Substances statement (Ukraine)
Обладнання відповідає вимогам Технічного регламенту щодо обмеження використання деяких 
небезпечних речовин в електричному та електронному обладнанні, затвердженого постановою Кабінету 
Міністрів України від 3 грудня 2008 № 1057

Substances Table (China)

SEPA Ecolabel User Information (China)
中国环境标识认证产品用户说明

噪声大于 63.0 dB(A)的办公设备不宜放置于办公室内，请在独立的隔离区域使用。

如需长时间使用本产品或打印大量文件，请确保在通风良好的房间内使用。

如您需要确认本产品处于零能耗状态，请按下电源关闭按钮，并将插头从电源插座断开。

您可以使用再生纸，以减少资源耗费。
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The regulation of the implementation on China energy label for 
printer, fax, and copier

Material Safety Data Sheet (MSDS)
Material Safety Data Sheets (MSDS) for supplies containing chemical substances (for example, toner) can be 
obtained by accessing the HP Web site at www.hp.com/go/msds.

EPEAT
Many HP products are designed to meet EPEAT. EPEAT is a comprehensive environmental rating that helps 
identify greener electronics equipment. For more information on EPEAT go to www.epeat.net. For information 
on HP's EPEAT registered products go to www.hp.com/hpinfo/globalcitizenship/environment/pdf/
epeat_printers.pdf.

For more information
To obtain information about these environmental topics:

● Product environmental profile sheet for this and many related HP products

● HP’s commitment to the environment

● HP’s environmental management system

● HP’s end-of-life product return and recycling program

● Material Safety Data Sheets

Visit www.hp.com/go/environment.

Also, visit www.hp.com/recycle.
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Declaration of conformity (base models)
Declaration of Conformity

according to ISO/IEC 17050-1 and EN 17050-1

Manufacturer's Name: HP Inc. DoC#: BOISB-1001-00 rel.8.0

Manufacturer's Address: 11311 Chinden Boulevard

Boise, Idaho 83714-1021, USA

declares, that the product

Product Name: HP LaserJet Professional CP1025 Color

Regulatory Model Number2) BOISB-1001-00

Product Options: ALL

Print Cartridges: CE310A, CE311A, CE312A, CE313A

conforms to the following Product Specifications:

SAFETY: IEC 60950-1:2005 +A1:2009 / EN60950-1: 2006 +A11:2009+A1:2010+A12:2011

IEC 60825-1:2007 / EN 60825-1:2007 (Class 1 Laser/LED Product)

IEC 62479:2010 / EN62479:2010

GB4943.1-2011

EMC: CISPR 22: 2008/ EN 55022:2010 - Class B1)

EN 61000-3-2 :2006 +A1:2009 +A2:2009

EN 61000-3-3 :2008

EN 55024: 2008

FCC Title 47 CFR, Part 15 Class B / ICES-003, Issue 4

GB9254-2008, GB17625.1-2003

ENERGY USE: Regulation (EC) No. 1275/2008

EN50564:2011, IEC 62301:2011

RoHS: EN 50581:2012

Supplementary Information:

The product herewith complies with the requirements of the EMC Directive 2004/108/EC and the Low Voltage Directive 2006/95/EC, the RoHS 

Directive 2011/65/EU and the Ecodesign Directive 2009/125/EC, and carries the CE-Marking  accordingly.

This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

1. The product was tested in a typical configuration with HP Personal Computer Systems.

2. For regulatory purposes, this product is assigned a Regulatory model number. This number should not be confused with the product name or 
the product number(s).

Shanghai, China

November 1, 2015

For regulatory topics only:
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European Contact: HP Deutschland GmbH, HP HQ-TRE, 71025 Boeblingen, Germany

USA Contact: HP Inc., 1501 Page Mill Road, Palo Alto 94304, U.S.A. 650-857-1501 www.hp.eu/certificates
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Declaration of conformity (wireless models)
Declaration of Conformity

according to ISO/IEC 17050-1 and EN 17050-1

Manufacturer's Name: HP Inc. DoC#: BOISB-1001-01 rel.9.0

Manufacturer's Address: 11311 Chinden Boulevard

Boise, Idaho 83714-1021, USA

declares, that the product

Product Name: HP LaserJet Professional CP1025nw Color

Regulatory Model Number2) BOISB-1001-01

Product Options: ALL

Print Cartridges: CE310A, CE311A, CE312A, CE313A

conforms to the following Product Specifications:

SAFETY: IEC 60950-1:2005 +A1:2009 / EN60950-1: 2006 +A11:2009 +A1:2010 +A12:2011

IEC 60825-1:2007 / EN 60825-1:2007 (Class 1 Laser/LED Product)

IEC 62479:2010 / EN62479:2010

GB4943.1-2011

EMC: CISPR 22: 2008/ EN 55022:2010 - Class B1)

EN 61000-3-2 :2006 +A1:2009 +A2:2009

EN 61000-3-3 :2008

EN 55024:2010

FCC Title 47 CFR, Part 15 Class B / ICES-003, Issue 4

GB9254-2008, GB17625.1-2003

ENERGY USE: Regulation (EC) No. 1275/2008

EN50564:2011, IEC 62301:2011

RoHS: EN 50581:2012

Supplementary Information:

The product herewith complies with the requirements of the EMC Directive 2004/108/EC, the Low Voltage Directive 2006/95/EC, the RoHS Directive 

2011/65/EU and the Ecodesign Directive 2009/125/EC, and carries the CE-Marking  accordingly.

This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

1. The product was tested in a typical configuration with HP Personal Computer Systems.

2. For regulatory purposes, this product is assigned a Regulatory model number. This number should not be confused with the product name or 
the product number(s).

Shanghai, China

November 1, 2015

For regulatory topics only:
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European Contact: HP Deutschland GmbH, HP HQ-TRE, 71025 Boeblingen, Germany

USA Contact: HP Inc., 1501 Page Mill Road, Palo Alto 94304, U.S.A. 650-857-1501 www.hp.eu/certificates
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Regulatory statements

FCC regulations

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to 
Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, uses, and can radiate radio frequency 
energy. If this equipment is not installed and used in accordance with the instructions, it may cause harmful 
interference to radio communications. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

● Reorient or relocate the receiving antenna.

● Increase separation between equipment and receiver.

● Connect equipment to an outlet on a circuit different from that to which the receiver is located.

● Consult your dealer or an experienced radio/TV technician.

NOTE: Any changes or modifications to the printer that are not expressly approved by HP could void the 
user’s authority to operate this equipment.

Use of a shielded interface cable is required to comply with the Class B limits of Part 15 of FCC rules.

Canada - Industry Canada ICES-003 Compliance Statement

CAN ICES-3(B)/NMB-3(B)

EMC statement (Korea)

Power cord instructions

Make sure your power source is adequate for the product voltage rating. The voltage rating is on the product 
label. The product uses either 110-127 Vac or 220-240 Vac and 50/60 Hz.

Connect the power cord between the product and a grounded AC outlet.

CAUTION: To prevent damage to the product, use only the power cord that is provided with the product.

Laser safety

The Center for Devices and Radiological Health (CDRH) of the U.S. Food and Drug Administration has 
implemented regulations for laser products manufactured since August 1, 1976. Compliance is mandatory for 
products marketed in the United States. The device is certified as a “Class 1” laser product under the U.S. 
Department of Health and Human Services (DHHS) Radiation Performance Standard according to the 
Radiation Control for Health and Safety Act of 1968. Since radiation emitted inside the device is completely 
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confined within protective housings and external covers, the laser beam cannot escape during any phase of 
normal user operation.

WARNING! Using controls, making adjustments, or performing procedures other than those specified in this 
user guide may result in exposure to hazardous radiation.

Laser statement for Finland

Luokan 1 laserlaite

Klass 1 Laser Apparat

HP LaserJet Professional CP1025, CP1025nw, laserkirjoitin on käyttäjän kannalta turvallinen luokan 1 
laserlaite. Normaalissa käytössä kirjoittimen suojakotelointi estää lasersäteen pääsyn laitteen ulkopuolelle. 
Laitteen turvallisuusluokka on määritetty standardin EN 60825-1 (2007) mukaisesti.

VAROITUS !

Laitteen käyttäminen muulla kuin käyttöohjeessa mainitulla tavalla saattaa altistaa käyttäjän 
turvallisuusluokan 1 ylittävälle näkymättömälle lasersäteilylle.

VARNING !

Om apparaten används på annat sätt än i bruksanvisning specificerats, kan användaren utsättas för osynlig 
laserstrålning, som överskrider gränsen för laserklass 1.

HUOLTO

HP LaserJet Professional CP1025, CP1025nw - kirjoittimen sisällä ei ole käyttäjän huollettavissa olevia 
kohteita. Laitteen saa avata ja huoltaa ainoastaan sen huoltamiseen koulutettu henkilö. Tällaiseksi 
huoltotoimenpiteeksi ei katsota väriainekasetin vaihtamista, paperiradan puhdistusta tai muita käyttäjän 
käsikirjassa lueteltuja, käyttäjän tehtäväksi tarkoitettuja ylläpitotoimia, jotka voidaan suorittaa ilman 
erikoistyökaluja.

VARO !

Mikäli kirjoittimen suojakotelo avataan, olet alttiina näkymättömällelasersäteilylle laitteen ollessa 
toiminnassa. Älä katso säteeseen.

VARNING !

Om laserprinterns skyddshölje öppnas då apparaten är i funktion, utsättas användaren för osynlig 
laserstrålning. Betrakta ej strålen.

Tiedot laitteessa käytettävän laserdiodin säteilyominaisuuksista: Aallonpituus 775-795 nm Teho 5 m W 
Luokan 3B laser.
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GS statement (Germany)

Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz vorgesehen. 
Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht im 
unmittelbaren Gesichtsfeld platziert werden.

Das Gerät ist kein Bildschirmarbeitsplatz gemäß BildscharbV. Bei ungünstigen Lichtverhältnissen (z. B. direkte 
Sonneneinstrahlung) kann es zu Reflexionen auf dem Display und damit zu Einschränkungen der Lesbarkeit 
der dargestellten Zeichen kommen.

Eurasian Conformity (Belarus, Kazakhstan, Russia)
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Additional statements for wireless products

FCC compliance statement—United States

Exposure to radio frequency radiation

CAUTION: The radiated output power of this device is far below the FCC radio frequency exposure limits. 
Nevertheless, the device shall be used in such a manner that the potential for human contact during normal 
operation is minimized.

In order to avoid the possibility of exceeding the FCC radio frequency exposure limits, human proximity to the 
antenna shall not be less than 20 cm (8 in) during normal operation.

This device complies with Part 15 of FCC Rules. Operation is subject to the following two conditions: (1) this 
device may not cause interference, and (2) this device must accept any interference, including interference 
that may cause undesired operation of the device.

CAUTION: Based on Section 15.21 of the FCC rules, changes of modifications to the operation of this product 
without the express approval by HP may invalidate its authorized use.

Australia statement

This device incorporates a radio-transmitting (wireless) device. For protection against radio transmission 
exposure, it is recommended that this device be operated no less than 20 cm from the head, neck, or body.

Brazil ANATEL statement

Este equipamento opera em caráter secundário, isto é, não tem direito à proteção contra interferência 
prejudicial, mesmo de estações do mesmo tipo, e não pode causar interferência a sistemas operando em 
caráter primário.

Canadian statements

For Indoor Use. This digital apparatus does not exceed the Class B limits for radio noise emissions from 
digital apparatus as set out in the radio interference regulations of the Canadian Department of 
Communications. The internal wireless radio complies with RSS 210 of Industry Canada.

Pour l´usage d´intérieur. Le présent appareil numérique n´émet pas de bruits radioélectriques dépassant les 
limites applicables aux appareils numériques de Classe B prescribes dans le règlement sur le brouillage 
radioélectrique édicté par le Ministère des Communications du Canada. Le composant RF interne est conforme 
à la norme CNR-210 d´Industrie Canada.

Exposure to Radio Frequency Radiation (Canada)

WARNING! Exposure to Radio Frequency Radiation. The radiated output power of this device is below the 
Industry Canada radio frequency exposure limits. Nevertheless, the device should be used in such a manner 
that the potential for human contact is minimized during normal operation.

To avoid the possibility of exceeding the Industry Canada radio frequency exposure limits, human proximity 
to the antennas should not be less than 20 cm (8 inches).
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European Union regulatory notice

The telecommunications functionality of this product may be used in the following EU and EFTA countries/
regions:

Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland, France, Germany, Greece, 
Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania, Luxembourg, Malta, Netherlands, Norway, 
Poland, Portugal, Romania, Slovak Republic, Slovenia, Spain, Sweden, Switzerland, and United Kingdom.

Notice for use in Russia

Существуют определенные ограничения по использованию беспроводных сетей (стандарта 802.11 b/g) с 
рабочей частотой 2,4 ГГц: Данное оборудование может использоваться внутри помещений с 
использованием диапазона частот 2400-2483,5 МГц (каналы 1-13). При использовании внутри 
помещений максимальная эффективная изотропно–излучаемая мощность (ЭИИМ) должна составлять не 
более 100мВт.

Mexico statement

Aviso para los usuarios de México

“La operación de este equipo está sujeta a las siguientes dos condiciones: (1) es posible que este equipo o 
dispositivo no cause interferencia perjudicial y (2) este equipo o dispositivo debe aceptar cualquier 
interferencia, incluyendo la que pueda causar su operación no deseada."

Para saber el modelo de la tarjeta inalámbrica utilizada, revise la etiqueta regulatoria de la impresora.

Taiwan statement

Korean statement
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Vietnam Telecom wired/wireless marking for ICTQC Type approved products
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E Supplies and accessories

● Order parts, accessories, and supplies

● Part numbers
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Order parts, accessories, and supplies

HP original print cartridge, imaging drum, and paper www.hp.com/go/suresupply

Order genuine HP parts or accessories www.hp.com/buy/parts

Order through service or support providers Contact an HP-authorized service or support provider.

Part numbers
The following list of accessories was current at the time of printing. Ordering information and availability of 
the accessories might change during the life of the product.

Print cartridges

Item Cartridge number Color Part number

HP LaserJet print cartridge 126A Black CE310A

Cyan CE311A

Yellow CE312A

Magenta CE313A

Imaging drums

Item Description Part number

Imaging drum Imaging drum CE314A

NOTE: The imaging drum installed in this product is covered by the product warranty. Replacement imaging 
drums have a one-year limited warranty from the date of installation. The imaging drum installation date 
displays on both the configuration page and on the supplies status page when the imaging drum reaches 
approximately 30% of its estimated remaining life. HP's Premium Protection Warranty applies only to the 
print cartridges for the product. 

Cables and interfaces

Item Description Part number

USB 2.0 printer cable (2-meter standard) A-to-B cable C6518A
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